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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. The Technical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, the Technical Support group works with Product Engineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s maintenance offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers automatic software upgrade protection

■ Global support that is available 24 hours a day, 7 days a week

■ Advanced features, including Account Management Services

For information about Symantec’s Maintenance Programs, you can visit our Web
site at the following URL:

www.symantec.com/techsupp/

Contacting Technical Support
Customers with a current maintenance agreement may access Technical Support
information at the following URL:

www.symantec.com/techsupp/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

www.symantec.com/techsupp/
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■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/techsupp/

Customer service
Customer service information is available at the following URL:

www.symantec.com/techsupp/

Customer Service is available to assist with the following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and maintenance contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs or manuals
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Maintenance agreement resources
If you want to contact Symantec regarding an existing maintenance agreement,
please contact the maintenance agreement administration team for your region
as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

Additional enterprise services
Symantec offers a comprehensive set of services that allow you to maximize your
investment in Symantec products and to develop your knowledge, expertise, and
global insight, which enable you to manage your business risks proactively.

Enterprise services that are available include the following:

These solutions provide early warning of cyber attacks, comprehensive threat
analysis, and countermeasures to prevent attacks before they occur.

Symantec Early Warning Solutions

These services remove the burden of managing and monitoring security devices
and events, ensuring rapid response to real threats.

Managed Security Services

Symantec Consulting Services provide on-site technical expertise from
Symantec and its trusted partners. Symantec Consulting Services offer a variety
of prepackaged and customizable options that include assessment, design,
implementation, monitoring, and management capabilities. Each is focused on
establishing and maintaining the integrity and availability of your IT resources.

Consulting Services

Educational Services provide a full array of technical training, security
education, security certification, and awareness communication programs.

Educational Services

To access more information about Enterprise services, please visit our Web site
at the following URL:

www.symantec.com

Select your country or language from the site index.
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Introducing HP Client
Manager

This chapter includes the following topics:

■ About HP Client Manager

■ Components of HP Client Manager

■ What you can do with HP Client Manager

■ Where to get more information

About HP Client Manager
HP Client Manager is a hardware management tool that lets you manage HP and
Compaq-branded desktops, notebooks, workstations, and HP Blade PCs. A
Web-based console centralizes management tasks to minimize visits to individual
desktops and reduce the time and cost of identifying and fixing problems manually.
HP Client Manager is a free product for HP customers and comes with a 90-day
evaluation license. After the evaluation period, you must activate the product and
install a permanent license to continue using HP Client Manager.

HP Client Manager is a solution in the Symantec Management Platform. It
leverages the platform’s abilities to provide extensive reporting, alerting,
policy-driven software delivery, and patch management.

HP Client Manager lets you perform the following management tasks remotely:

■ Track HP client hardware.

■ Collect valuable inventory information such as processor, memory, video, and
security settings.

1Chapter



■ Monitor a client computer’s health and receive hardware alerts at the Symantec
Management Console or the local computer.

■ Intelligently deploy HP driver and BIOS updates (SoftPaqs).

■ Remotely configure BIOS settings.

■ Remotely manage TPM (Trusted Platform Module) devices on HP ProtectTools
enabled clients.

See “What you can do with HP Client Manager” on page 16.

You can install HP Client Manager as a suite or as a solution. The suite includes
Out of Band Management Component and other components. Out of Band
Management Component lets you manage client computers regardless of the state
of their power, operating system, or management agents.

See “About Out of Band Management Component” on page 15.

See “Components of HP Client Manager” on page 12.

See “What you can do with HP Client Manager” on page 16.

See “Where to get more information” on page 19.

Components of HP Client Manager
The components of HP Client Manager help you manage the HP client computers
in your environment.

HP Client Manager is a solution in the Symantec Management Platform. It
leverages the platform’s abilities to provide extensive reporting, alerting,
policy-driven software delivery, and patch management.

See “How HP Client Manager integrates with the Symantec Management Platform”
on page 14.

Table 1-1 Components of HP Client Manager

DescriptionComponent

Works with the Altiris Agent to perform tasks on the target computers and communicate
with the Symantec Management Platform.

The HP Client Manager Agent (plug-in) must be installed on every HP client computer
that you plan to manage.

See “About the HP Client Manager Agent” on page 57.

HP Client Manager
Agent (plug-in)

Introducing HP Client Manager
Components of HP Client Manager
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Table 1-1 Components of HP Client Manager (continued)

DescriptionComponent

Provides a centralized Web console from which you can manage your HP client computers.
This portal page consists of Web parts, which provide links to the tasks that you can
perform and the summary information about your managed computers.

See “About the HP Client Manager Home page” on page 61.

HP Client Manager
Home page

Help you manage your HP client computers.

HP Client Manager is integrated with HP Instant Support System Health Scan, HP Instant
Support Diagnostics, and HP System Software Manager (SSM). The advantage of using
these tools through HP Client Manager is that you can perform the management tasks
remotely.

See “About the HP tools in HP Client Manager” on page 143.

HP tools

Actions that are performed on a computer. Server tasks are run on the Notification Server
computer. Client tasks are run on managed computers.

HP Client Manager contains predefined tasks to perform the management actions on your
managed HP computers. For example, these tasks can perform the following actions:
discover HP computers, inventory the HP clients, manage SoftPaqs, perform health
monitoring, perform diagnostics, and manage Embedded Security, and perform backups.

Tasks

The sets of rules that control the execution of automated actions. Policies can be scheduled
or based on incoming data that triggers an immediate action. Policies determine when an
action should start and who or what should be notified of the results.

HP Client Manager contains predefined policies to install and upgrade the HP Client
Manager Agent, deploy SoftPaq updates, and send client health alerts.

Policies

Define the groups of computers that you are most likely to target for specific management
tasks. HP Client Manager contains many predefined filters, which are used as default
targets in the HP Client Manager tasks and policies.

See “About the predefined filters in HP Client Manager” on page 64.

Filters

Display and filter the information that is collected from your managed HP computers so
that you can analyze their data.

See “Viewing the HP Client Manager reports” on page 66.

Reports

Lets you manage client computers regardless of the state of their power, operating system,
or management agents. Out of Band Management Component is included with HP Client
Manager.

See “About Out of Band Management Component” on page 15.

Out of Band
Management
Component
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How HP Client Manager integrates with the Symantec Management
Platform

The Symantec Management Platform provides a set of services that IT-related
solutions leverage. For example, some of the platform services include security,
reporting, communications, package deployment, and Configuration Management
Database (CMDB) data. Because the solutions share the same platform, they can
also share the platform data. The solutions are easier to use because they work
in a common environment and are administered through a common interface.

For more information about any aspect of the Symantec Management Platform,
see the Symantec Management Platform Help.

The HP Client Manager solution integrates and interacts with the Symantec
Management Platform.

Table 1-2 The Symantec Management Platform components that HP Client
Manager uses

DescriptionsComponent

The primary server that is installed with the Symantec Management Platform.

The Notification Server computer is responsible for solution coordination, the primary
user interface, policy-based administration, reporting, and notification. A Notification
Server computer can act as a secondary server in a hierarchy. It can also be designated as
a reporting server, which is used only to generate and display enterprise-wide reports.

Notification Server
computer

The Symantec Management Platform service that processes events, facilitates
communications with managed computers, and coordinates the work of the other Symantec
Management Platform services.

Notification Server
software

The database that stores all the information about managed computers.CMDB (Configuration
Management Database)

The software that establishes communication between Notification Server and the
computers in your network. The computers that have the Altiris Agent installed are called
managed computers.

Notification Server and the Altiris Agent interact to monitor and manage each computer
from the Symantec Management Console.

See “About the Altiris Agent” on page 47.

The Altiris Agent also lets you install and manage the solution agents and plug-ins that
add solution-specific functionality.

See “About the HP Client Manager Agent” on page 57.

Altiris Agent

Introducing HP Client Manager
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Table 1-2 The Symantec Management Platform components that HP Client
Manager uses (continued)

DescriptionsComponent

The Symantec Management Console is the core interface for Symantec Management
Platform and any solutions or components that are installed. From this console, you can
run or schedule tasks, view system resources, view reports, change configuration settings,
update system settings, and perform other actions. These items are available from the
console menus.

The majority of the HP Client Manager functionality is located on the HPClientManager
Home page, which you access from the Symantec Management Console.

See “About the HP Client Manager Home page” on page 61.

SymantecManagement
Console

HP Client Manager uses platform tasks to perform the following actions:

■ Discover HP client computers.

See “Discovering HP client computers” on page 55.

■ Install the HP Instant Support Diagnostics tool.

See “Installing the HP Instant Support Diagnostics tool” on page 137.

■ Perform an inventory of non-HP computers.

See “Gathering the client computer inventory” on page 71.

■ Back up your managed HP computers.

See “Performing an HP backup” on page 147.

Platform tasks

About Out of Band Management Component
Out of Band Management Component lets you manage client computers regardless
of the state of their power, operating system, or management agents. Out of Band
Management Component is included with HP Client Manager. It was formerly
known as Altiris Out of Band Management Solution.

Remotely managing a client computer often requires the managed computer to
be in-band, which means that it is turned on with the operating system running.

Out of Band Management Component lets you manage the client computers that
are in one of the following out-of-band states:

■ The computer is plugged in, but not actively running (off, standby, hibernated).

■ The operating system is not loaded (software or hardware boot failure).

■ The software-based management agent is not available.

Computers with Intel AMT, ASF, or DASH capabilities can be managed out of
band. You can remotely change the computer’s power state, collect hardware
inventory, and perform other management tasks that would normally require a
visit to the computer.
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When you install HP Client Manager as a suite, Out of Band Management
Component and other components are included. When you install the HP Client
Manager solution only, Out of Band Management Component is not included.
However, you can install Out of Band Management Component at any time after
the HP Client Manager installation.

See “Installing HP Client Manager and the Symantec Management Platform”
on page 33.

See “Installing HP Client Manager on an existing Symantec Management Platform”
on page 35.

For more information about using Out of Band Management Component, see the
Out of BandManagement Help.

What you can do with HP Client Manager
HP Client Manager provides comprehensive, automatic, and remote administration
of the HP client computers in your environment.

See “About HP Client Manager” on page 11.

Table 1-3 What you can do with HP Client Manager

DescriptionTask

HP Client Manager contains the predefined tasks that run automatically to perform the
following actions:

■ Gather extensive inventory data from your managed HP computers.

For example, you can capture detailed information about the processors, hard drives,
memory, BIOS, serial numbers, operating systems, and battery and chassis details.

■ Gather general inventory data from managed non-HP computers.

You can view and analyze the inventory data to track and analyze different aspects of
your HP computers. Other functions in HP Client Manager can also use the inventory data.
For example, the computer inventory identifies which computers support Embedded
Security.

See “About client computer inventory” on page 69.

Gather inventory
information from client
computers.
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Table 1-3 What you can do with HP Client Manager (continued)

DescriptionTask

HP Client Manager interacts with the Embedded Security module of HP ProtectTools,
which protects against unauthorized access to user data or credentials on client computers.

HP Client Manager lets you secure your client infrastructure in less time by performing
the following tasks remotely:

■ Initialize the Embedded Security on the HP client computers.

HP Client Manager uses the computer inventory information to identify which
computers support Embedded Security and which ones need to be initialized.

■ Change the owner (Embedded Security administrator) password.

■ Reset an Embedded Security user’s password.

■ Archive and restore the Embedded Security credentials and settings on the client
computers.

See “About HP Embedded Security” on page 76.

Remotely manage HP
Embedded Security on
any managed HP
computers that have
the Trusted Platform
Module (TPM) device.

HP Client Manager integrates with HP Instant Support System Health Scan to help you
automate the management of HP SoftPaq updates. HP Client Manager contains a predefined
health scan task that runs daily. The health scan identifies issues on your managed HP
computers and the SoftPaqs that are needed to resolve those issues.

After the health scan runs, you can take the following actions:

■ Review the results of the health scan.

You can view a report that lists the computers that have issues and shows the
recommendations for resolving the issues. Those recommendations can include links
to any related HP support documents or a list of SoftPaqs that are required.

■ Download the SoftPaqs that the health scan identified.

■ Deliver the SoftPaqs to the client computers that need it.

■ Monitor the success of the SoftPaq deliveries.

See “About HP SoftPaq management” on page 94.

Proactively and
remotely manage the
driver and BIOS updates
(SoftPaqs) that HP
provides.

You can manage the BIOS settings of your managed HP computers by performing the
following tasks:

■ Deploy new BIOS settings to one or more groups of client computers.

For example, you can change the BIOS passwords, hide the availability of certain ports,
or change the boot order of the computer’s devices

■ Use the HP BIOS reports to view and analyze the BIOS data, which is gathered during
the client computer inventory process.

You can use the predefined report and you can create custom reports to filter the BIOS
information in different ways.

See “About HP BIOS Settings” on page 109.

Remotely manage and
modify the BIOS and
security settings of your
managed HP computers.
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Table 1-3 What you can do with HP Client Manager (continued)

DescriptionTask

The computer health is defined as a set of elements that perform within a range of values
and functionality. When a health-related element is outside a set range or does not function
in the desired state, a health alert is created. Monitoring the health of client computers
lets you address issues before performance is affected.

You can monitor and evaluate computer health by performing the following tasks:

■ Specify the general categories of hardware health issues to monitor.

For example, monitor for hard drive failures or free space, overheating, faulty batteries
or charge levels, and changes to hardware assets.

■ Configure the specific hardware health issues to monitor on one or more managed HP
computers.

For example, you can disable the threshold monitoring of disk space on certain
computers.

■ Configure the health alerts to appear to the user on the client computer.

■ Automate the process of running HP health monitor reports and sending notifications.

■ Use the HP health monitor reports to view the alert data and identify and analyze the
health issues.

See “About health monitoring and alerts” on page 120.

Proactively monitor the
health of your managed
HP computers and
receive health
automated alerts at the
SymantecManagement
Console or on the client
computer.

HP Client Manager integrates with the HP Instant Support Diagnostics tool to reduce the
time it takes to troubleshoot and resolve hardware problems.

HP Client Manager uses predefined tasks to perform the following actions automatically:

■ Install the HP Instant Support Diagnostics tool on managed HP client computers.

This task runs weekly.

■ Run the diagnostics and gather the resulting data.

This task runs monthly to checks your computers for the hardware issues that are
tracked in the HP Instant Support knowledge base.

You can view reports to verify the installation of the diagnostics tool and to analyze and
identify issues with your managed HP client computers.

See “About HP Instant Support diagnostics” on page 135.

Automate the
troubleshooting of
hardware and
configuration issues on
HP client computers.

The HP Supported Systems list contains all the computer models that HP Client Manager
supports. HP Client Manager uses the information in this list to identify HP client
computers.

The master list is in XML format and resides on a Web page. The information in the list
is also stored locally in the CMDB (Configuration Management Database) on the Notification
Server computer. You must update the local list periodically to ensure that it contains the
most recent computers.

See “Updating the HP Supported Systems list” on page 142.

Update your HP
Supported Systems list.
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Table 1-3 What you can do with HP Client Manager (continued)

DescriptionTask

HP Client Manager uses the following HP tools: HP Instant Support System Health Scan,
HP Instant Support Diagnostics, and HP System Software Manager (SSM). You need to
download updated versions of these tools from the HP Web site when HP makes them
available.

HP Client Manager can update these tools automatically with a Windows scheduled task
and you can also update the tools on demand.

See “About the HP tools in HP Client Manager” on page 143.

Update the HP tools
that HP Client Manager
uses to help you
manage your HP client
computers.

HP Client Manager uses the HP Backup and Recovery Manager tool to run and report
backups of your managed HP computers.

Client Manager contains a predefined task that runs daily to performs a one-time backup
of the primary drive on each HP client computer. The backup data is stored in a protected
area on the primary hard drive. If an HP client computer suffers a data loss, you can restore
its data from the backup.

See “About HP backup and recovery” on page 146.

Perform automatic,
remote backups of your
managed HP computers.

The data that is collected from managed HP computers is stored in the CMDB (Configuration
Management Database). To manage the size of the CMDB, you can specify how long certain
types of data are stored.

See “Purging HP data” on page 149.

Purge HP data.

Create Web-based reports on hardware inventory and business-critical details, such as
computers with health alerts or changes to hardware assets.

For more information, see the topics about customizing reports in the Symantec
Management Platform Help.

Customize Web reports.

HP Client Manager supports remote access using HTTPS, SSL, and VPN protocols. It uses
advanced functionality to regulate the file downloading speed and compression of files
and to activate a checkpoint restart if the download fails.

Support remote users.

HP Client Manager provides tight integration with other Symantec client lifecycle
management solutions.

Integrate with other
solutions.

Where to get more information
Use the following documentation resources to learn and use this product.
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Table 1-4 Documentation resources

LocationDescriptionDocument

http://kb.altiris.com/

You can search for the product name under
Release Notes.

Information about new features and
important issues.

This information is available as an article in
the knowledge base.

Release Notes

■ The Documentation Library, which is
available in the Symantec Management
Console on the Help menu.

■ The Documentation page, which is
available at the following URL:

http://www.altiris.com/Support/
Documentation.aspx

When you open the Documentation page,
look for the section that applies to this
product.

Information about how to use this product,
including detailed technical information and
instructions for performing common tasks.

This information is available in PDF format.

User Guide

The Documentation Library, which is
available in the Symantec Management
Console on the Help menu.

Context-sensitive help is available for most
screens in the Symantec Management
Console and the HP Client Manager Home
page.

You can open context-sensitive help in the
following ways:

■ The F1 key

■ The Context command, which is available
in the Symantec Management Console
on the Help menu.

Information about how to use this product,
including detailed technical information and
instructions for performing common tasks.

Help is available at the solution level, the
suite level, and the Symantec Management
Platform level.

This information is available in HTML help
format.

Help

In addition to the product documentation, you can use the following resources to
learn about Altiris products.

Table 1-5 Altiris information resources

LocationDescriptionResource

http://kb.altiris.com/Articles, incidents, and issues about Altiris
products.

Knowledge base
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Table 1-5 Altiris information resources (continued)

LocationDescriptionResource

http://www.symantec.com/connect
/endpoint-management-virtualization

An online magazine that contains best
practices, tips, tricks, forums, and articles
for users of this product.

Symantec Connect

(formerly Altiris Juice)
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Installing HP Client
Manager

This chapter includes the following topics:

■ About installing HP Client Manager

■ Installation requirements for HP Client Manager

■ Sources for information about installing the Symantec Management Platform

■ Scenarios for installing HP Client Manager

■ Installing HP Client Manager 7.0 and Symantec Management Platform for the
first time

■ Upgrading from HP Client Manager 6.x to 7.0

■ Downloading the HP Client Manager installation file

■ Installing Symantec Installation Manager

■ Installing HP Client Manager and the Symantec Management Platform

■ Installing HP Client Manager on an existing Symantec Management Platform

■ Upgrading from an earlier 7.0 version of HP Client Manager

About installing HP Client Manager
HP Client Manager must be installed with the Symantec Management Platform.
HP Client Manager, the Symantec Management Platform, and other products are
installed from Symantec Installation Manager.
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Symantec Installation Manager (SIM) handles the installation and initial
configuration of the Symantec Management Platform and its suites and solutions.
This easy-to-use installation wizard verifies installation readiness and steps you
through the product installation and configuration.

If you need to update, install, or uninstall HP Client Manager after the initial
installation, Symantec Installation Manager is available in the Symantec
Management Console.

See “Installation requirements for HP Client Manager” on page 24.

See “Scenarios for installing HP Client Manager” on page 26.

Installation requirements for HP Client Manager
HP Client Manager must be installed with the Symantec Management Platform.
Therefore, the server on which you install HP Client Manager must meet the
requirements for the Symantec Management Platform.

See “Sources for information about installing the Symantec Management Platform”
on page 25.

You might want to install HP Client Manager in a test environment before you
roll it out to your production environment.

Table 2-1 Installation requirements for HP Client Manager

DescriptionRequirement

You must select an appropriate Windows server on which to install the Symantec
Management Platform, HP Client Manager, and any additional suites or solutions. This
server is referred to as the Notification Server computer.

For testing, you can use a computer that meets the minimal server requirements.

As you roll out HP Client Manager to a domain or a production workgroup, you might
increase RAM and disk space or upgrade the server. The upgrade requirements depend
on the number of managed computers and the needs of your environment and IT team.

Server

HP Client Manager supports a range of HP and Compaq-branded desktops, notebooks,
workstations, and HP Blade PCs. A list of the computers that HP Client Manager supports
is available from the following URL:

http://www.altiris.com/docs/support/HPClientManager/HPCMSSupportedSysIds_7_0.xml

See “About the HP Supported Systems list” on page 141.

For testing, you can use a single client computer.

Client computers
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Table 2-1 Installation requirements for HP Client Manager (continued)

DescriptionRequirement

You can run HP Client Manager in either a workgroup environment or on a domain.

For testing, the simplest network setup is a workgroup. Running in a workgroup lets you
perform the basic installation and management tasks and get a sense of the capabilities
of HP Client Manager.

Network type

HP Client Manager runs on most of the current versions of Microsoft Windows. For more
information, see the HP Client Manager Release Notes.

Note: If a client computer runs Windows XP SP2 with firewall enabled, you must unblock
ports 80 and 445. You can block these ports again after the installation. You can also create
an exception for the Altiris Agent in the WindowsFirewall dialog box. HP Client Manager
functions properly only if the Altiris Agent is installed successfully on the client computer.

Operating system

Sources for informationabout installing theSymantec
Management Platform

The Altiris Knowledgebase and other online resources contain information about
installing the Symantec Management Platform.

See “Installation requirements for HP Client Manager” on page 24.

Table 2-2 Sources for information about installing the Symantec Management
Platform

LocationSourceInformation

This article is available from the following locations:

■ The knowledge base, which is located at the
following URL:

http://kb.altiris.com/

■ The Documentation Web site, which is available
at the following URL:

http://www.altiris.com/Support/
Documentation.aspx

The latest HP Client
Manager Release Notes

The requirements and other
installation notes for the latest
version of HP Client Manager
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Table 2-2 Sources for information about installing the Symantec Management
Platform (continued)

LocationSourceInformation

■ The knowledge base, which is located at the
following URL:

http://kb.altiris.com/

■ Knowledge base article 45141, Release Notes
Available for Symantec Management Platform 7,
which is located at the following URL:

https://kb.altiris.com/display/1/articleDirect/
index.asp?aid=45141&r=3.762454E-02

■ The Documentation Web site, which is available
from the following URL:

http://www.altiris.com/Support/Documentation.aspx

The latest Symantec
Management Platform
Release Notes

The requirements and other
installation notes for the latest
version of the Symantec
Management Platform

https://kb.altiris.com/display/1/kb/
article.asp?aid=45732&link=

Knowledge base article
45732, Installing the
Symantec Management
Platform products

An overview of the installation
process and links to additional
resources

https://kb.altiris.com/display/1/kb/
article.asp?aid=45597&link=

Knowledge base article
45597, Symantec
Management Platform
Capacity Planning

■ The minimum system
requirements for installing the
Symantec Management
Platform products and the
recommended system
requirements for installing the
products in different
environments

■ Information about how to
configure the Symantec
Management Platform in
different environments

https://kb.altiris.com/display/1/kb/
article.asp?aid=45803&link=

Knowledge base article
45803, Altiris 7
Planning and
Implementation Guide

Capacity recommendations, design
models, scenarios, test results, and
optimization best practices to
consider when you plan or
customize an Altiris 7.x
infrastructure

Scenarios for installing HP Client Manager
The installation process that you follow for HP Client Manager depends on which
scenario fits your organization’s situation.
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Table 2-3 Typical scenarios for installing HP Client Manager

DescriptionScenario

HP Client Manager is not yet installed and you want to evaluate it in a test environment
before you deploy it to your production environment. You must install both HP Client
Manager and the Symantec Management Platform.

The installation process is the same as for a new installation, except for the capacity and
complexity of your network setup.

See “Installing HP Client Manager 7.0 and Symantec Management Platform for the first
time” on page 27.

Installation in a test
environment

Neither HP Client Manager nor any other Symantec Management Platform product is
installed. You must install both HP Client Manager and the Symantec Management
Platform.

See “Installing HP Client Manager 7.0 and Symantec Management Platform for the first
time” on page 27.

New installation

You have already implemented a Symantec Management Platform 7.0 product and now
you are ready to implement HP Client Manager in that environment.

See “Installing HP Client Manager on an existing Symantec Management Platform”
on page 35.

Addition of HP Client
Manager to an existing
installation of the
Symantec Management
Platform

You have an installation of HP Client Manager 6.x and you want to upgrade to 7.0.

See “Upgrading from HP Client Manager 6.x to 7.0” on page 28.

Upgrade from HP Client
Manager 6.x

You have an installation of HP Client Manager 7.0 and an update is available.

You can upgrade HP Client Manager through Symantec Installation Manager.

See “Upgrading from an earlier 7.0 version of HP Client Manager” on page 37.

Upgrade from an earlier
7.0 version

When the installation is finished, you can proceed to the steps for setting up HP
Client Manager.

See “Setting up HP Client Manager” on page 40.

Installing HP Client Manager 7.0 and Symantec
Management Platform for the first time

Use this process to install HP Client Manager when you do not have any Symantec
Management Platform products installed. This process is appropriate for installing
HP Client Manager in a test environment or a production environment.
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Before you begin, ensure that you meet the requirements for installing HP Client
Manager and the Symantec Management Platform.

See “Installation requirements for HP Client Manager” on page 24.

Table 2-4 Process for installing HP Client Manager 7.0 and Symantec
Management Platform for the first time

DescriptionActionStep

You must set up a network environment that consists of a Windows server
and one or more HP client computers that can access the server. This server
is referred to as the Notification Server computer.

Your network environment must meet the requirements for the Symantec
Management Platform. For testing, you can use a network that meets the
minimum requirements.

See “Installation requirements for HP Client Manager” on page 24.

Set up the environment
for the Symantec
Management Platform
7.0.

Step 1

You can download a file that installs Symantec Installation Manager and
contains the information to install the Symantec Management Platform
and HP Client Manager.

See “Downloading the HP Client Manager installation file” on page 30.

Download the HP Client
Manager installation
file.

Step 2

HP Client Manager is installed from Symantec Installation Manager (SIM).
You must install Symantec Installation Manager on the Notification Server
computer.

See “Installing Symantec Installation Manager” on page 32.

Install Symantec
Installation Manager.

Step 3

HP Client Manager requires an installation of the Symantec Management
Platform. You can use Symantec Installation Manager to install both
products at the same time.

For testing, you can accept the defaults for most of the installation settings.

See “Installing HP Client Manager and the Symantec Management Platform”
on page 33.

Install HP Client
Manager and the
Symantec Management
Platform.

Step 4

When the installation is finished, you can proceed to the steps for setting up HP
Client Manager.

See “Setting up HP Client Manager” on page 40.

Upgrading from HP Client Manager 6.x to 7.0
HP Client Manager 7.0 contains major feature upgrades, which replace the
functions of HP Client Manager 6.x. When you upgrade from HP Client Manager
6.x to 7.0, you must also upgrade your Notification Server installation to Symantec
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Management Platform 7.0. Symantec Installation Manager helps you perform the
upgrade.

For more information about upgrading to Symantec Management Platform 7.0,
see the Symantec Management Platform Installation Guide. This document is
available from the Documentation Web site, which is located at the following URL:

http://www.altiris.com/Support/Documentation.aspx

Table 2-5 Process for upgrading from HP Client Manager 6.x to 7.0

DescriptionActionStep

Your network environment must meet the requirements for the Symantec
Management Platform 7.0. You might need to upgrade certain aspects of
your network environment before you upgrade the software. For example,
you might need to increase the allotted disk space for the database or
complete additional design optimization tasks.

See “Installation requirements for HP Client Manager” on page 24.

Upgrade your
environment for the
Symantec Management
Platform 7.0.

Step 1

You can download a file that installs Symantec Installation Manager and
contains the information to install the Symantec Management Platform
and HP Client Manager.

See “Downloading the HP Client Manager installation file” on page 30.

Download the HP Client
Manager installation
file.

Step 2

HP Client Manager is installed from Symantec Installation Manager (SIM).
You install Symantec Installation Manager on the Notification Server
computer.

See “Installing Symantec Installation Manager” on page 32.

Install Symantec
Installation Manager.

Step 3

HP Client Manager requires an installation of the Symantec Management
Platform. You can use Symantec Installation Manager to upgrade both
products at the same time.

When you run Symantec Installation Manager, include both the Symantec
Management Platform and HP Client Manager in the installation.

See “Installing HP Client Manager and the Symantec Management Platform”
on page 33.

This upgrade procedure is nearly the same as for a new installation, with
the following exception:

If the Optional Installs page appears, be sure to select the option to install
the Migration Wizard components.

Upgrade to the
Symantec Management
Platform 7.0 and HP
Client Manager 7.0.

Step 4
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Table 2-5 Process for upgrading from HP Client Manager 6.x to 7.0 (continued)

DescriptionActionStep

When the installation is finished, you have the option to run the Migration
Wizard, which lets you migrate any Altiris 6.x data to the 7.0 product.

For more information about migrating Altiris 6.x data, see knowledge base
article 44969,Migration of 6.xData to SymantecManagement Platform7.0.
It is available at the following URL:

https://kb.altiris.com/article.asp?article=44969&p=1

For more information about the HP Client Manager data that can be
migrated, see the latest HP Client Manager Release Notes.

See “Where to get more information” on page 19.

Migrate any Altiris 6.x
data to the Symantec
Management Platform
7.0 product.

Step 5

When the upgrade is finished, you can proceed to the steps for setting up HP
Client Manager.

See “Setting up HP Client Manager” on page 40.

Downloading the HP Client Manager installation file
HP Client Manager is installed from Symantec Installation Manager (SIM). You
can download a file that installs Symantec Installation Manager and contains the
information to install the Symantec Management Platform and HP Client Manager.
The file that you download is a compressed file that you extract to obtain the SIM
installation file.

This task is a step in the process for installing HP Client Manager.

See “About installing HP Client Manager” on page 23.

See “Installing HP Client Manager 7.0 and Symantec Management Platform for
the first time” on page 27.

You can download the installation file directly to the Windows server on which
you plan to install the Symantec Management Platform and HP Client Manager.
This server is referred to as the Notification Server computer. If the Notification
Server computer does not have Internet access, you can download the file to a
different computer.
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Note:This procedure describes how to download the installation file for HP Client
Manager. If you plan to install another Symantec Management Platform product,
you must download the installation file for that particular product. For example,
to install Client Management Suite, you must download the installation from that
product’s page on the Symantec Web site.

To download the HP Client Manager installation file

1 Launch a Web browser and go to the following URL:

http://www.symantec.com/business/theme.jsp?themeid=hp_client_manager

2 On the HP Client Manager page, click Download Now.

3 On the Download page, in Select a product to download, click HP Client
Manager 7, and then click Submit.

4 On the Eligibility Export Restrictions page, click I Agree.

5 On the SymAccount Login page, enter your user name and password.

If you are a new user, create a new user account.

6 On the Software Download page, at the right of the HP Client Manager 7
row, click DOWNLOAD NOW.

7 When you are prompted, save the file.

The file name is atrs-hp_client_manager_7_0.exe. This file is a compressed
wrapper for the SIM installation file.

8 When the download finishes, close the download dialog box and any download
Web pages that are still open.

9 If you did not download the file to the Notification Server computer, copy or
move the file to that server.

10 On the Notification Server computer, in Windows Explorer, navigate to the
downloaded file and double-click it.

11 In the Symantec Installation Manager - Install Package dialog box, click
Continue.

12 When you are prompted to select the folder to unzip the files to, click Ok.

13 When the file extraction is finished, click Ok.

The extracted file is named Symantec_sim_7_0x.exe, where x is the product
build number.

14 When the Symantec Installation Manager setup launches, take one of the
following actions:
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■ Install Symantec Installation Manager.
See “Installing Symantec Installation Manager” on page 32.

■ If you prefer to install Symantec Installation Manager later, in the
Welcome dialog box, click Close.

Installing Symantec Installation Manager
Symantec Installation Manager (SIM) handles the installation and initial
configuration of the Symantec Management Platform and its suites and solutions,
including HP Client Manager. This easy-to-use installation wizard verifies
installation readiness and steps you through the product installation and
configuration.

After the initial platform installation, Symantec Installation Manager is available
in the Symantec Management Console. You can use it to install, upgrade, and
uninstall HP Client Manager and the other Symantec Management Platform
products.

For more information, see the SymantecManagementPlatform InstallationGuide.

Before you can install Symantec Installation Manager, you must have downloaded
its installation file and the server must have access to the file’s location.

See “Downloading the HP Client Manager installation file” on page 30.

This task is a step in the process for installing HP Client Manager.

See “Installing HP Client Manager 7.0 and Symantec Management Platform for
the first time” on page 27.

To install Symantec Installation Manager

1 On the Notification Server computer, navigate to and double-click the
following file:

Symantec_sim_7_0x.exe

where x is the product build number.

2 On the Welcome page, click Next.

3 On the LicenseAgreement page, read and accept the license agreement, and
then click Next.

4 On the Destination Folder page, accept the default destination path, and
then click Begin install.

5 When the installation is complete, take the following steps:

■ Check or uncheck AutomaticallylaunchSymantecInstallationManager.
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■ Click Finish.

Installing HP Client Manager and the Symantec
Management Platform

HP Client Manager requires an installation of the Symantec Management Platform.
If you do not have the Symantec Management Platform installed, you can install
both products at the same time. This procedure is appropriate for installing HP
Client Manager in a test environment or a production environment. For testing,
you can accept the defaults for most of the installation settings.

Before you begin this installation, you must have installed Symantec Installation
Manager.

See “Installing Symantec Installation Manager” on page 32.

You can install HP Client Manager as a suite or as a solution. The suite includes
Out of Band Management Component and other components. If you install the
HP Client Manager solution only, you can install Out of Band Management
Component later.

See “About Out of Band Management Component” on page 15.

This task is a step in the process for installing HP Client Manager.

See “About installing HP Client Manager” on page 23.

Note: The steps that are described in this procedure assume that you install HP
Client Manager instead of some other Symantec Management Platform product.
These steps might differ from those that are required for the Symantec
Management Platform suites, solutions, and other products.

To install HP Client Manager and the Symantec Management Platform

1 On the Windows Start menu, click Programs>Altiris>SymantecInstallation
Manager > Symantec Installation Manager.

2 On the InstallNewProducts page, in the list of available products, check HP
Client Manager from Symantec.

3 If you are prompted to install any prerequisite software, click OK.

4 On the Install New Products page, click Review selected products.

5 On the Selected Products and Features page, review the products to be
installed, and then click Next.
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6 On the End User License Agreement page, read and accept the license
agreements, and then click Next.

7 On the Install Readiness Check page, take one of the following actions:

Click Next.If all requirements are
met

Take the following steps:

■ Click Cancel.
■ Install any software that is required and make sure that

any other requirements are met.

For example, if the wrong version of Microsoft Internet
Explorer is installed, uninstall it and then install the
required version.

■ Restart this procedure.

If additional
requirements are listed

8 On the Product Licensing page, take one of the following actions:

Click Next.If this installation is for evaluation
or you do not have a permanent
license for HP Client Manager

You can click Install licenses to apply the license
now, or you can click Next and apply it later.

See “Installing a license for HP Client Manager”
on page 44.

If you have obtained the
permanent license for HP Client
Manager

9 On the Notification Server Configuration page, enter the user credentials,
and then click Next.

This page appears only when you install the Symantec Management Platform.
You can configure the email settings now or after the installation.

To configure the email settings now, enter the domain, user name, and
password that you want to use to access Notification Server. The user account
that you specify must be a Windows user with local administrator rights to
the Notification Server computer.

See “Configuring the email settings in Notification Server” on page 59.

10 On the DatabaseConfiguration page, provide information about the database,
and then click Next.

This page appears only when you install the Symantec Management Platform.

In most cases, you can accept the default values.
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11 On the Computers to Manage page, take one of the following actions:

Click Begin Install.To perform the Altiris
Agent installation later

Select the computers on which to install the agent in one of
the following ways:

■ On the Active Directory tab or the Domain tab, check
the domain or expand the domain and check specific
computers.

■ On the Manual tab, type the computer name or a domain.

Click the Right Arrow option to add the computers to the
SelectedComputers list at the right of the dialog box. Type
the connection credentials or accept the default. You can
click Validate computers to verify to connections to the
selected computers.

When you finish selecting the computers, click Begininstall.

To discover computers
and install the Altiris
Agent now

The installation can take some time to complete.

12 When the installation finishes, on the Installation Complete page, check or
uncheck any of the following options, and then click Finish.

■ Launch Symantec Management Console
See “Accessing the HP Client Manager Home page” on page 62.

■ Run Notification Server 6 Migration Wizard
For more information about the Migration Wizard, see knowledge base
article 44969, Migration of 6.x Data to Symantec Management Platform
7.0. It is available at the following URL:
https://kb.altiris.com/article.asp?article=44969&p=1

13 If the Symantec Installation Manager window is still open, you can close it.

InstallingHPClientManager on an existing Symantec
Management Platform

You can install HP Client Manager on an existing 7.0 installation of the Symantec
Management Platform. HP Client Manager provides additional management
capabilities for your managed HP computers.

Before you begin, ensure that the Symantec Management Platform is installed
and implemented and that you meet the requirements for installing HP Client
Manager.
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See “Installation requirements for HP Client Manager” on page 24.

HP Client Manager is installed from Symantec Installation Manager in the same
way as any other Symantec Management Platform product.

You can install HP Client Manager as a suite or as a solution. The suite includes
Out of Band Management Component and other components. If you install the
HP Client Manager solution, you can install Out of Band Management Component
later.

See “About Out of Band Management Component” on page 15.

This task is a step in the process for installing HP Client Manager.

See “About installing HP Client Manager” on page 23.

To install HP Client Manager on an existing Symantec Management Platform

1 On the Windows Start menu, click Programs>Altiris>SymantecInstallation
Manager > Symantec Installation Manager.

2 On the Installed Products page, click Install new products.

3 On the Install New Products page, select the product to install in either of
the following ways:

By default, the page is filtered to display suites.

Click HP Client Manager from Symantec, and then click
Next.

To install the HP Client
Manager suite

■ Click the Filter option on the right, and then click
Solutions.

■ When the solutions are displayed, click Symantec HP
Client Manager, and then click Next.

To install the HP Client
Manager solution

4 On the OptionalInstalls page, select the options to install the documentation
and any additional products, and then click Next.

5 On the End User License Agreement page, read and accept the license
agreement, and then click Next.

6 On the Contact information page, enter your contact information, and then
click Next.

7 On the Review Installation Details page, review the items to be installed,
and then click Begin Install.

The installation can take some time to complete.
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8 On the Product Licensing page, take one of the following actions:

Click Next.If this installation is for evaluation
or you do not have a permanent
license for HP Client Manager

You can click Install licenses to apply the license
now, or you can click Next and apply it later.

See “Installing a license for HP Client Manager”
on page 44.

If you have obtained the
permanent license for HP Client
Manager

9 On the Installation Complete page, check or uncheck any of the following
options, and then click Finish.

■ Launch Symantec Management Console
See “Accessing the HP Client Manager Home page” on page 62.

■ Run Notification Server 6 Migration Wizard
For more information about the Migration Wizard, see knowledge base
article 44969, Migration of 6.x Data to Symantec Management Platform
7.0. It is available at the following URL:
https://kb.altiris.com/article.asp?article=44969&p=1

10 If the Symantec Installation Manager window is still open, you can close it.

Upgrading from an earlier 7.0 version of HP Client
Manager

When you have an installation of HP Client Manager 7.0 and an update is available,
you can use Symantec Installation Manager to install it.

For information about any installation requirements or whether data migration
is required for a specific update, see the latest HP Client Manager Release Notes
and SymantecManagementPlatformReleaseNotes. You can search for the release
notes in the knowledge base, which is located at the following URL:

http://kb.altiris.com/

To upgrade from an earlier 7.0 version of HP Client Manager

1 On the Windows Start menu, click Programs>Altiris>SymantecInstallation
Manager > Symantec Installation Manager.

2 On the Installed Products page, click View and install updates.
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3 On the ProductUpdates page, click the options to update HP Client Manager
and any other products that you want to update, and then click Next.

4 Step through and complete the installation wizard as you would for a new
installation.

See “Installing HP Client Manager on an existing Symantec Management
Platform” on page 35.
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Setting up HP Client
Manager

This chapter includes the following topics:

■ Setting up HP Client Manager

■ Quick Start Web part

■ Activating HP Client Manager

■ Installing a license for HP Client Manager

■ Discovering all computers

■ About the Altiris Agent

■ About configuring Altiris Agent settings

■ Methods for installing the Altiris Agent on client computers

■ Manually pushing the Altiris Agent to HP client computers

■ Installing the Altiris Agent with a scheduled policy (scheduled push)

■ Disabling Windows XP simple file sharing

■ Installing the Altiris Agent from a Web page (manual pull)

■ Verifying server-to-client communication

■ Discovering HP client computers

■ Viewing the discovered client computers

■ About the HP Client Manager Agent
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■ Installing the HP Client Manager Agent

■ Upgrading the HP Client Manager Agent

■ Configuring the email settings in Notification Server

Setting up HP Client Manager
Before you use HP Client Manager to manage HP client computers, you must set
it up and prepare your environment for its use.

For your convenience, several of the setup tasks are accessible on the HP Client
Manager Home page, under the Quick Start Web part. Other setup tasks run
automatically.

See “Quick Start Web part” on page 43.

Table 3-1 Setting up HP Client Manager

DescriptionActionStep

HP Client Manager is a free product for HP customers and comes with a
90-day evaluation license. After the evaluation period, you must activate
the product and install a permanent license to continue using HP Client
Manager.

See “Activating HP Client Manager” on page 43.

See “Installing a license for HP Client Manager” on page 44.

You can skip this step when you install HP Client Manager in a test
environment.

Activate HP Client
Manager and install the
full license.

Step 1

Identifies the computers that are on your network and creates resources
for them in the Configuration Management Database (CMDB).

When you install HP Client Manager in a test environment and in certain
other situations, you can skip this step. You can install the Altiris Agent
without completing a full network discovery operation.

See “Discovering all computers” on page 46.

Discover all computers.Step 2
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Table 3-1 Setting up HP Client Manager (continued)

DescriptionActionStep

The Altiris Agent must be installed on each client computer that you want
to manage through the Symantec Management Platform and HP Client
Manager.

See “Methods for installing the Altiris Agent on client computers”
on page 49.

(Optional) Before you install the Altiris Agent, you can configure the settings
that determine how the agent is deployed.

See “About configuring Altiris Agent settings” on page 48.

Install the Altiris Agent.Step 3

You can verify that the Altiris Agent is installed on HP client computers
and that the server computer and client computers can communicate.

See “Verifying server-to-client communication” on page 54.

Verify server-to-client
communication.

Step 4

Finds the HP client computers that are on your network so that you can
manage them.

HP Client Manager contains a predefined task that discovers HP client
computers and non-HP client computers. By default, the task runs every
hour.

You can skip this step unless you need to run it on a different schedule or
on a different group of computers.

See “Discovering HP client computers” on page 55.

Discover HP client
computers.

Step 5

You can use reports and filters to view the HP computers that were
discovered. For example, after you add new HP computers to your network,
you can view a report to verify that those new computers were discovered.

You can also view the discovered computers that HP Client Manager does
not support.

See “Viewing the discovered client computers” on page 56.

(Optional) View the
discovered HP
computers and
non-supported
computers.

Step 6
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Table 3-1 Setting up HP Client Manager (continued)

DescriptionActionStep

The HP Client Manager Agent must be installed on every HP client computer
that you plan to manage. This agent works with the Altiris Agent to perform
tasks on the target computers and communicate with the Symantec
Management Platform.

HP Client Manager contains a predefined policy that installs the HP Client
Manager Agent to your managed HP computers. You must schedule and
turn on (enable) the policy to install the agent.

See “Installing the HP Client Manager Agent” on page 58.

(Upgrade installations only) HP Client Manager contains a predefined policy
that upgrades the HP Client Manager Agent on HP client computers.
Schedule and turn on (enable) this policy after you upgrade from an earlier
version of HP Client Manager.

See “Upgrading the HP Client Manager Agent” on page 59.

Install or upgrade the
HP Client Manager
Agent.

Step 7

HP Client Manager uses several tools from HP to help you manage your HP
client computers. After you install or upgrade HP Client Manager, you
should update the HP tools to ensure that you have the most current
versions. You can perform a manual update by running the Update HP
Tools wizard.

See “Updating HP tools with the Update HP Tools wizard” on page 145.

Update the HP tools.Step 8

HP Embedded Security support is provided through a hardware security
chip that is embedded in some models of HP computers. If any of your
managed HP computers contain the security chip, we recommend that you
initialize Embedded Security immediately after setting up HP Client
Manager. The initialization reduces the risk that an unauthorized user, a
computer worm, or a virus might gain access to the computers.

See “Initializing Embedded Security on HP client computers” on page 78.

Initialize Embedded
Security, if applicable.

Step 9

This tool lets you run the HP Instant Support diagnostics on HP client
computers.

The diagnostics tool automates the troubleshooting of hardware and
configuration issues on HP client computers.

See “Installing the HP Instant Support Diagnostics tool” on page 137.

(Optional) Install the HP
Instant Support
Diagnostics tool.

Step 10
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Quick Start Web part
On the HP Client Manager Home page, the Quick Start Web part provides
shortcuts for several of the initial tasks that you perform to set up HP Client
Manager.

See “Setting up HP Client Manager” on page 40.

Table 3-2 Tasks on the Quick Start Web part

DescriptionTask

Lets you register with Symantec as an HP Client Manager user
and obtain a permanent license key.

See “Activating HP Client Manager” on page 43.

Activate Product

Identifies the computers that are on your network and creates
resources for them in the Configuration Management Database
(CMDB).

See “Discovering all computers” on page 46.

DiscoverallComputers

The Altiris Agent must be deployed to each client computer that
you want to manage through the Symantec Management Platform
and HP Client Manager.

See “Methods for installing the Altiris Agent on client computers”
on page 49.

Install the Altiris
Agent

To manage HP computers, you must install the HP Client Manager
Agent (plug-in) on them. This agent works with the Altiris Agent
to perform tasks on the target computers and communicate with
the Symantec Management Platform.

See “Installing the HP Client Manager Agent” on page 58.

Deliver HP Client
Manager Plug-in

See “About the HP Client Manager Home page” on page 61.

Activating HP Client Manager
HP Client Manager is a free product for HP customers and comes with a 90-day
evaluation license. To continue using HP Client Manager after the evaluation
period, you must activate the product and install a permanent license. The
activation process consists of registering as an HP Client Manager user and
downloading a free, permanent license file. You can activate HP Client Manager
at any time before the 90-day evaluation license expires.

This task is a step in the process for setting up HP Client Manager.

43Setting up HP Client Manager
Quick Start Web part



See “Setting up HP Client Manager” on page 40.

You can skip this step when you install HP Client Manager in a test environment.

After you activate HP Client Manager and download the permanent license file,
you can install the license.

See “Installing a license for HP Client Manager” on page 44.

To activate HP Client Manager

1 On the HP Client Manager Home page, under Quick Start, click Activate
Product.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the Web page that opens, read the restrictions, terms, and conditions, and
then click I AGREE.

3 On the SymAccount Login page, take one of the following actions:

■ If you already have an account, under Existing Users, type your account
information, and then click LOGIN.

■ If you do not have an account, under SignupNow :Createanewaccount,
type your email address and a unique password, and then click CREATE
ACCOUNT.

4 Complete any informational pages or survey pages that appear.

For example, if you create a new account, you must provide account
information.

5 On the SOFTWARE DOWNLOAD page, follow the instructions to download
the free, permanent license for HP Client Manager.

6 When you are prompted, save the file to the computer on which HP Client
Manager is installed.

The default location for license files is as follows:

installation directory\Altiris\Symantec Installation

Manager\Licenses

The file name is HPCM_License.zip.

7 In Windows Explorer, navigate to the HPCM_License.zip file and double-click
it to extract the license text file.

Installing a license for HP Client Manager
When you activate HP Client Manager, you receive a free permanent license that
replaces your initial evaluation license. The license information is in a text file
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that you save during the product activation. Before you can install the license,
you must have access to the license file.

See “Activating HP Client Manager” on page 43.

You can install the permanent HP Client Manager license at any time before the
90-day evaluation license expires. You use Symantec Installation Manager to
install the licenses for all Symantec Management Platform products.

For more information about installing licenses, see the Symantec Management
Platform Installation Guide.

This task is a step in the process for setting up HP Client Manager.

See “Setting up HP Client Manager” on page 40.

You can skip this step when you install HP Client Manager in a test environment.

To install a license for HP Client Manager

1 On the Windows Start menu, click Program Files > Altiris > Symantec
Installation Manager > Symantec Installation Manager.

2 On the Install Products page, click Add/Update licenses.

3 On the Product Licensing page, click Install licenses.

4 In the Select License Files dialog box, select the text file that contains the
license for HP Client Manager, and then click Open.

If you saved the license file in a location other than the default Licenses
directory, navigate to the other location.

5 If you are prompted to overwrite the existing license, click Yes.

6 When the license installation finishes, on the ProductLicensing page, confirm
that the HP Client Manager license information is updated, and then click
Close.

7 If you are prompted to restart services, select one of the following options:

Restarts the services and applies the new license immediately.

Warning:Restarting services can interrupt other applications
that are running.

Restart services

Let the license be applied without interrupting services. The
license application might be delayed.

Apply without
restart

8 Close Symantec Installation Manager.
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Discovering all computers
Computer discovery identifies the computers that are on your network. When a
computer is discovered, a resource is created for it in the CMDB (Configuration
Management Database) in the Symantec Management Platform. Before you can
manage any computers, you must discover them so that you can install the Altiris
Agent on them. Use this discovery process when you need to install the Altiris
Agent on several computers in a large environment.

For more information, see the topics about discovering computers in the Symantec
Management Platform Help.

This task is a step in the process for setting up HP Client Manager.

See “Setting up HP Client Manager” on page 40.

You can skip this step in the following situations:

■ You installed HP Client Manager in a test environment.

■ You installed HP Client Manager in a workgroup environment.

■ You discovered computers during the HP Client Manager installation.

■ You installed HP Client Manager on an existing installation of Symantec
Management Platform, in which the computers were already discovered.

After you discover the client computers on your network, you can install the Altiris
Agent on them.

See “Methods for installing the Altiris Agent on client computers” on page 49.

To discover all computers

1 On the HPClientManagerHome page, under QuickStart, click Discoverall
Computers.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the Domain Membership/WINS Import page, in Add Domain, specify
the domains to search in any of the following ways:

■ Type the domain name in the box, and then click the Add symbol (the
blue plus sign).
You can repeat this step to add more domains.

■ Click the Browse symbol (the yellow file folder) and in the DomainPicker
dialog box, select one or more domains to search, and then click OK.

3 (Optional) To enter a different user name and password for the domain so
that Notification Server has access, take the following steps:

■ Select the domain from the list.

Setting up HP Client Manager
Discovering all computers

46



■ Click the Edit symbol (the pencil).

■ On the Discovery Credentials page, click Use these credentials.

■ Type the Login ID and Password, and then click OK.

4 Select at least one of the following options:

Discovers all the computers that share files or printers or that
run the Windows Messenger Service.

This option is for small, peer-to-peer environments. This
option does not work in the following situations: the
computers are not in the browse list; or the computers are not
registered as sharing files or printers on the domain.

Domain Browse List

Discovers all the computers that have trust accounts in the
domain.

This discovery includes all the computers in the domain that
run Windows 2000 or later. This method is slower than the
Domain Browse List method and does not identify the
operating system of the computers.

DomainMembership

5 Select one of the following options:

Begins the discovery immediately.Discover Now

Lets you select a specific time to run the discovery.

If you select one of the schedule options, click Save changes.

Schedule

6 Close the Domain Membership/WINS Import page.

About the Altiris Agent
The Altiris Agent is the software that establishes communication between
Notification Server and the computers in your network. Computers with the Altiris
Agent installed on them are called managed computers. Notification Server then
interacts with the Altiris Agent to monitor and manage each computer from the
Symantec Management Console.

Notification Server and the Altiris Agent work together to provide the following
management functions:

■ Monitoring hardware and software

■ Scheduling software installations and file updates
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■ Collecting basic inventory information

■ Managing policies and packages

The Altiris Agent was formerly called the Notification Server Client or NS Client.

The Altiris Agent must be installed on each client computer that you want to
manage through the Symantec Management Platform and HP Client Manager.
You might have had the option to install the Altiris Agent during the HP Client
Manager installation.

Before you install the Altiris Agent on client computers, you can configure the
settings that determine how the agent is deployed.

See “About configuring Altiris Agent settings” on page 48.

See “About the HP Client Manager Agent” on page 57.

About configuring Altiris Agent settings
The Altiris Agent must be deployed to each client computer that you want to
manage through the Symantec Management Platform and HP Client Manager.

See “About the Altiris Agent” on page 47.

Before you install the Altiris Agent on client computers, you can configure the
settings that determine how the agent is deployed.

You can configure the Altiris Agent settings in the following ways:

The Settings option lets you configure the settings for each
manual push installation. The Altiris Agent pull installation uses
the same defaults except for Download agent package from
closest Package Server, which is irrelevant.

For more information, see the topics about setting the Altiris
Agent installation options in theSymantecManagementPlatform
Help.

On the Altiris Agent
Install page

The global configuration settings apply to all Altiris Agents on
all managed computers. These settings are applied as a global
agent settings policy, so they are updated in the same way as any
other policy. By default, the global agent settings policy is
refreshed hourly.

For more information, see the topics about configuring the global
agent settings in the Symantec Management Platform Help.

In the global agent
settings
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The targeted agent settings policy lets you configure the general
parameters that control the Altiris Agent, including how the
agent communicates with Notification Server. You can apply
these settings to particular groups of computers. For example,
some groups of computers may have different purposes, or you
may want to treat servers differently from other managed
computers.

For more information, see the topics about configuring the
targeted agent settings in the Symantec Management Platform
Help.

In the targeted agent
settings

See “Methods for installing the Altiris Agent on client computers” on page 49.

Methods for installing the Altiris Agent on client
computers

After you discover the client computers on your network, you can install the Altiris
Agent on them. A computer on which the Altiris Agent is installed is considered
a managed computer.

See “About the Altiris Agent” on page 47.

You must have administrator rights to install the Altiris Agent.

You might have had the option to install the Altiris Agent during the HP Client
Manager installation.

Table 3-3 Methods for installing the Altiris Agent on client computers

DescriptionMethod

Lets you deploy the Altiris Agent immediately to the Windows
target computers that you select.

See “Manually pushing the Altiris Agent to HP client computers”
on page 50.

Manual push method

Lets you schedule a policy that installs the Altiris Agent to the
target computers at a specific time.

See “Installing the Altiris Agent with a scheduled policy
(scheduled push)” on page 52.

Scheduled push method
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Table 3-3 Methods for installing the Altiris Agent on client computers
(continued)

DescriptionMethod

Lets you install the Altiris Agent manually on a single client
computer by downloading the agent from a Web page.

Use this method when you cannot push the Altiris Agent to the
client computer or when the client computer has not been
discovered. For example, you cannot install the Altiris Agent
remotely to a workgroup computer on which the Windows XP
simple file sharing option is enabled.

See “Installing the Altiris Agent from a Web page (manual pull)”
on page 53.

Manual pull method

For more information, see the topics about installing the Altiris Agent in the
Symantec Management Platform Help.

Manually pushing the Altiris Agent to HP client
computers

You can deploy the Altiris Agent immediately to the Windows target computers
that you select.

You must have administrator rights to install the Altiris Agent.

This task is a step in the process for setting up HP Client Manager.

See “Setting up HP Client Manager” on page 40.

For more information, see the topics about installing the Altiris Agent in the
Symantec Management Platform Help.

Note: If the Windows XP simple file sharing option is enabled on a client computer
within a workgroup, it does not allow non-guest access over the network. As a
result, it does not allow the Altiris Agent to be deployed remotely. You can either
disable simple file sharing or install the Altiris Agent from a Web page.

See “Disabling Windows XP simple file sharing” on page 53.

See “Installing the Altiris Agent from a Web page (manual pull)” on page 53.
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To manually push the Altiris Agent to HP client computers

1 On the HP Client Manager Home page, under Quick Start, click Deliver
Altiris Agent.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the Altiris Agent Install page, click the Install Altiris Agent tab.

3 On the Install Altiris Agent tab, under Altiris Agent installs to computers,
select the client computers on which to install the Altiris Agent in one of the
following ways:

Type a computer name in the box and click Add.Add known computers
by name.

Click SelectComputers and in the SelectComputers dialog
box, select client computers from the Availablecomputers
list. Click OK.

This list contains all the computers that have been
discovered. To filter this list, in the Group drop-down list,
select the appropriate organizational view or group.

Select one or more
computers that have
been discovered.

Click SelectComputers and in the SelectComputers dialog
box, under Selected computers, click Open. In the Open
dialog box, select a filter and click OK.

The Discovered computers not reporting inventory filter
contains all the discovered client computers that do not
have the Altiris Agent installed.

Select the computers
from an existing filter.

You can repeat any of these actions to add more computers to the list.

4 On the Install Altiris Agent tab, under Altiris Agent installs to computers,
click Install Altiris Agent.

5 In the Altiris Agent Installation Options dialog box, take the following
actions:

■ Click Show the Altiris Agent icon in the system tray.

■ Configure any other settings as needed.

■ Click Proceed with Install.

51Setting up HP Client Manager
Manually pushing the Altiris Agent to HP client computers



Installing the Altiris Agent with a scheduled policy
(scheduled push)

You can schedule a policy that installs the Altiris Agent to the target computers
at a specific time.

You must have administrator rights to install the Altiris Agent.

This task is a step in the process for setting up HP Client Manager.

See “Setting up HP Client Manager” on page 40.

Note: When the Windows XP simple file sharing option is enabled on a client
computer within a workgroup, non-guest access over the network is not allowed.
As a result, the Altiris Agent cannot be installed remotely. You can either disable
the simple file sharing or install the Altiris Agent from a Web page.

See “Disabling Windows XP simple file sharing” on page 53.

See “Installing the Altiris Agent from a Web page (manual pull)” on page 53.

To install the Altiris Agent with a scheduled policy

1 On the HP Client Manager Home page, under Quick Start, click Deliver
Altiris Agent.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the Altiris Agent Install page, click the Install Altiris Agent tab.

3 On the InstallAltirisAgent tab, under ScheduledPushtoComputers, under
Apply To, select the computers on which to install the Altiris Agent.

You can use the default filter or select a different set of target computers.

The Discovered computers not reporting inventory filter contains all the
discovered client computers that do not have the Altiris Agent installed.

For more information, see the topics about specifying the targets of a policy
or task in the Symantec Management Platform Help.

4 Under When, schedule the policy to run at a specific date and time or on a
shared schedule.

5 Turn on the policy.

At the upper right of the page, click the colored circle and then click On.

6 Click Save changes.
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Disabling Windows XP simple file sharing
If the Windows XP simple file sharing option is enabled on a client computer
within a workgroup, it does not allow non-guest access over the network. As a
result, it does not allow the Altiris Agent to be installed remotely. Before you can
push the Altiris Agent to a workgroup computer, you must first disable its simple
file sharing option.

After you disable simple file sharing, you can deliver the Altiris Agent.

See “Manually pushing the Altiris Agent to HP client computers” on page 50.

See “Installing the Altiris Agent with a scheduled policy (scheduled push)”
on page 52.

As an alternative, you can install the Altiris Agent from a Web page.

See “Installing the Altiris Agent from a Web page (manual pull)” on page 53.

To disable simple file sharing

1 On the Windows Start menu, click My Computer.

2 In the My Computer window, on the Tools menu, click Folder Options.

3 In the Folder Options dialog box, click the View tab.

4 Under Advanced Settings, uncheck the Use simple file sharing
(Recommended) check box, and then click OK.

5 Close the My Computer window.

Installing the Altiris Agent from a Web page (manual
pull)

You can install the Altiris Agent manually on a single client computer by
downloading the agent from a Web page.

Use this installation method in the following situations:

■ When you cannot push the Altiris Agent to the client computer.
For example, when the Windows XP simple file sharing option is enabled on
a workgroup computer, non-guest access over the network is not allowed. As
a result, the Altiris Agent cannot be installed remotely.
As an alternative, you can disable the simple file sharing option.
See “Disabling Windows XP simple file sharing” on page 53.

■ When the client computer has not been discovered.

You must have administrator rights to install the Altiris Agent.
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This task is a step in the process for setting up HP Client Manager.

See “Setting up HP Client Manager” on page 40.

To find the URL for downloading the Altiris Agent

1 On the Notification Server computer, on the HPClientManagerHome page,
click 4. Deliver Altiris Agent.

2 On the AltirisAgentInstall page, under URLofdownloadpage, copy or note
the URL that appears.

3 Close the Altiris Agent Install page.

To install the Altiris Agent from a Web page

1 On a client computer, open a browser and go to the URL that you found on
the Altiris Agent Install page.

The default URL is as follows

http://NSName/Altiris/NS/Agent/AltirisAgentDownload.aspx

Where NSName is the name of your Notification Server computer.

2 If you are prompted to install the bootstrap utility
(AltirisAgentInstBootstrap.cab), click Install.

3 On the AltirisAgentDownload page, click Clickhere tobeginthedownload
and install.

Verifying server-to-client communication
You can verify that the Altiris Agent is installed on HP client computers and that
the server computer and client computers can communicate.

You can perform the verification in the following ways:

When the Altiris Agent is installed on a client computer, its icon
appears in the computer’s system tray. On the client computer,
this agent and its icon are named Symantec Management Agent.
If the icon does not appear, the agent was not installed properly.

On the client computers

Setting up HP Client Manager
Verifying server-to-client communication

54



In a larger environment with several client computers, it is more
practical to verify the client-to-server communication by running
an inventory report. As part of its routine, the Altiris Agent sends
basic inventory information to the Notification Server computer
soon after it is installed. This information includes the managed
computers that were recently inventoried.

See To verify the Altiris Agent installation with an inventory
report.

You may want to run the Altiris Agent basic inventory (sorted
by last update) report to check the client-to-server
communication.

With an inventory
report

To verify the Altiris Agent installation with an inventory report

1 In the Symantec Management Console, on the Reports menu, click All
Reports.

2 In the left pane, click Reports > 6.0 Legacy Reports > Notification Server
Infrastructure > Agent > Altiris Agent Inventory.

Discovering HP client computers
After the Altiris Agent is installed, the predefined Discover HP Computers task
runs automatically on all client computers. This task identifies all the HP
computers in your network as well as the computers that HP Client Manager does
not support.

By default, this task runs every hour. You can change the schedule and targets
for this task but not the settings.

This task is a step in the process for setting up HP Client Manager.

See “Setting up HP Client Manager” on page 40.

You can skip this step unless you need to run it on a different schedule or on a
different group of computers.

It takes some time to discover the computers. After the HP computers are
discovered, you can view them.

See “Viewing the discovered client computers” on page 56.
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To view or schedule the Discover HP Computers task

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, click HPClientManager>HPClientManagerConfiguration
> Discover HP Computers.

3 To view the settings for running the task, on the task page, under Software
Settings, click Advanced.

4 On the task page, under Task Status, schedule the task and select the target
computers.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

5 When you finish scheduling the task, you can close the task page.

Viewing the discovered client computers
After the Discover HP Computers task runs, you can use reports and filters to
view the HP computers that were discovered. For example, after you add new HP
computers to your network, you can view a report to verify that those new
computers were discovered.

You can also view the discovered computers that HP Client Manager does not
support.

See “Discovering HP client computers” on page 55.

This task is a step in the process for setting up HP Client Manager.

See “Setting up HP Client Manager” on page 40.

To view discovered computers in a report

1 In the Symantec Management Console, on the Reports menu, click All
Reports.

2 In the left pane, click through one of the following folder hierarchies:

■ HP Client Manager > HP Client Information > HP Supported Computer
Information > All HP Computers by IP Address
Displays the HP client computers that have been discovered.

■ HP Client Manager > Non Supported Computers > Non Supported
Computer Information
Displays the non-HP client computers that have been discovered.

3 To display the latest information, in the right pane, click Refresh.
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4 Under Parameters, you can select additional ways to organize and display
the information. After you select new parameters, click Refresh.

5 (Optional) You can print the report or save it in a variety of formats. Other
actions might be available depending on the type of report.

For more information, see the topics about viewing and managing resource
data with reports in the Symantec Management Platform Help.

To view discovered computers in a filter

1 In the Symantec Management Console, on the Manage menu, click Filters.

2 In the left pane, click HP Client Manager Filters, and then click one of the
following filters:

Displays the HP client computers that
have been discovered but do not have the
HP Client Manager Agent installed.

Discovered Computers Requiring HP
Client Manager Agent

Displays the non-HP client computers that
have been discovered.

Unsupported HP Client Manager
Computers

3 To display the latest information, in the right pane, click Updatemembership.

About the HP Client Manager Agent
The HP Client Manager Agent (plug-in) must be installed on every HP client
computer that you plan to manage. This agent works with the Altiris Agent to
perform tasks on the target computers and communicate with the Symantec
Management Platform. The HP Client Manager Agent requires the Altiris Agent.

See “About the Altiris Agent” on page 47.

The HP System Health Scan tool and the HP System Software Manager (SSM) tool
are incorporated into the HP Client Manager Agent. The tools perform their tasks
on the client computers and the agent reports the resulting data to the Notification
Server computer.

You can use a predefined policy to install the HP Client Manager Agent on new
HP client computers automatically. Another predefined policy can upgrade the
HP Client Manager Agent whenever you upgrade HP Client Manager.

See “Installing the HP Client Manager Agent” on page 58.

See “Upgrading the HP Client Manager Agent” on page 59.
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Installing the HP Client Manager Agent
The HP Client Manager Agent must be installed on every HP client computer that
you plan to manage. This agent works with the Altiris Agent to perform tasks on
the target computers and communicate with the Symantec Management Platform.

See “About the HP Client Manager Agent” on page 57.

The HP Client Manager Agent Install policy lets you schedule the agent installation
on the target computers at a specific time. By default, this policy is turned off.
You must schedule and turn on (enable) the policy to install the agent.

This task is a step in the process for setting up HP Client Manager.

See “Setting up HP Client Manager” on page 40.

Before you begin this task, you must install the Altiris Agent on target computers.

See “Methods for installing the Altiris Agent on client computers” on page 49.

To install the HP Client Manager Agent

1 On the HP Client Manager Home page, under Quick Start, click Deliver HP
Client Manager Plug-in.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the HP Client Manager Agent Install page, under Applied to, select the
target computers on which to install the HP Client Manager Agent.

You can use the default filter or select a different set of target computers.
When the policy runs, it ignores any computers that already have the agent
installed.

For more information, see the topics about specifying the targets of a policy
or task in the Symantec Management Platform Help.

3 Under Schedule, click Addschedule to schedule the policy to run at a specific
date and time or during a span of time.

You can specify as many schedules as you need.

For more information, see the topics about specifying a policy schedule in
the Symantec Management Platform Help.

4 Turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

5 Click Save changes.
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Upgrading the HP Client Manager Agent
When you upgrade HP Client Manager from an earlier version, you must upgrade
the HP Client Manager Agent that is on your managed HP computers.

The HP Client Manager Upgrade policy performs the agent upgrade. By default,
this policy is turned on You can skip this step unless you need to run it on a
different schedule or on a different group of computers.

This task is a step in the process for setting up HP Client Manager after you
perform an upgrade.

See “Setting up HP Client Manager” on page 40.

See “About the HP Client Manager Agent” on page 57.

To view or configure the HP Client Manager Agent Upgrade policy

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, click Agent/Plug-ins>HPClientManagerAgent>HPClient
Manager Agent Upgrade.

3 (Optional) On the HP Client Manager Agent Upgrade page, under Applied
to, select the target computers on which to upgrade the HP Client Manager
Agent.

You can use the default filter or select a different set of target computers.

For more information, see the topics about specifying the targets of a policy
or task in the Symantec Management Platform Help.

4 Under Schedule, click Addschedule to schedule the policy to run at a specific
date and time or during a span of time.

You can specify as many schedules as you need.

For more information, see the topics about specifying a policy schedule in
the Symantec Management Platform Help.

5 Turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

6 Click Save changes.

Configuring the email settings in Notification Server
You can define a mail server and the email addresses for the email messages that
Notification Server can send. For example, Notification Server can send notices
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when reports run successfully, automation actions are executed, and system
scalability checks are performed.

If you configured the email settings during the Symantec Management Platform
installation, you usually do not have to change them.

Warning:These settings are global and they affect all of the Symantec Management
Platform. If other solutions are installed, do not enter the settings and email
addresses that are specific to HP Client Manager administrators. Instead, you can
customize the HP Client Manager automation policies.

See “Customizing an HP Client Manager automation policy” on page 130.

To configure the email settings in Notification Server

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, click Settings > Notification Server > Notification Server
Settings.

3 In the right pane, click theE-mail tab.

4 Under DefaultE-mailAddresses, in To, type the email address of the person
who should receive the emails from Notification Server.

The email address can be any valid SMTP address that your SMTP server
recognizes.

5 (Optional) Configure other email settings as needed.

For more information, see the topics about email server and address settings
in the Symantec Management Platform Help.

6 Click Send test email to ensure that the email works.

7 After you confirm that the email works, click OK.
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Performing common tasks
in HP Client Manager

This chapter includes the following topics:

■ About the HP Client Manager Home page

■ Accessing the HP Client Manager Home page

■ HP Client Manager Home page

■ About the predefined filters in HP Client Manager

■ Viewing the predefined filters in HP Client Manager

■ Scheduling and selecting target computers in an HP Client Manager task

■ Viewing the HP Client Manager reports

■ Viewing the Microsoft Windows 7 readiness reports

■ About platform tasks in HP Client Manager

About the HP Client Manager Home page
You can use the HP Client Manager Home page as the starting point for all your
HP client tasks.

This page is a portal page, which contains several Web parts. The Web parts
provide links to the tasks that you can perform and summary information about
your managed computers. You can collapse a Web part or modify the home page
altogether.

See “HP Client Manager Home page” on page 63.
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You can start the HP Client Manager Home page from the Notification Server
computer or from a remote client computer.

See “Accessing the HP Client Manager Home page” on page 62.

Accessing the HP Client Manager Home page
The HPClientManagerHome page consists of the Web parts that provide access
to HP Client Manager-related tasks and status information.

See “About the HP Client Manager Home page” on page 61.

You can start the HP Client Manager Home page from the Notification Server
computer or from a remote client computer. A remote connection requires that
the remote computer has access to the Notification Server computer and runs
supported versions of Microsoft Windows and Microsoft Internet Explorer.

For more information about accessing the Symantec Management Console, see
the Symantec Management Platform Help.

Accessing theHPClientManagerHomepage from theNotification Server computer

1 On the Notification Server computer, on the Windows Start menu, click All
Programs>Altiris>AltirisConsolex, where x is the current version number.

2 In the Symantec Management Console, on the Home menu, click HP Client
Manager.

Accessing the HP Client Manager Home page from a client computer

1 Log on to a remote computer.

Use an account that has administrator privileges to access the Notification
Server computer.

2 Open a Web browser and go to the following URL:

http://Notification Server name/Altiris/Console

where Notification Server name is the name of the Notification Server
computer.

The Notification Server computer name should be the fully qualified domain
name. You can use https if necessary. If the Notification Server computer is
not on port 80, include the appropriate port number after the Notification
Server computer name.

3 In the Symantec Management Console, on the Home menu, click HP Client
Manager.
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HP Client Manager Home page
The HPClientManagerHome page consists of the Web parts that provide access
to HP Client Manager-related tasks and status information.

See “About the HP Client Manager Home page” on page 61.

See “Accessing the HP Client Manager Home page” on page 62.

Table 4-1 Web parts on the HP Client Manager Home page

DescriptionWeb part

Provides the links to all the management tasks that are available through HP Client Manager.

The following Web parts are available:

■ Quick Start
Lists most of the tasks that you perform to set up HP Client Manager.

See “Quick Start Web part” on page 43.

■ Administrative Tasks
Lists the tasks that are performed on the HP Client Manager server.

■ Management Tasks
Lists the tasks that are performed on client computers.

■ Other features you can evaluate
Lists the other Symantec solutions that are available for evaluation.

Left pane

Contains the Web parts that show the status of HP computers.

The following Web parts are available:

■ HP Health Alert Trending
Summarizes the alert summaries that appear in the right pane. You can view a summary
of the last three months or six months of data. The data in this graph is displayed over
units of weeks. Therefore, you might have to wait a few days before any data is visible
in the graph.

■ Percent of computers needing updates
Contains the reports that reflect all the HP computers that have had HP Diagnostics or
an HP Health Scan run. Use the drop-down list to select the graph to view.

■ Summary of HP Computers
Shows a breakdown by percentage of computer types: Desktop computers, notebooks,
workstations, and blades. When you click an area of the graph, the Supported HP
Computers details report lists all the computers that the area represents.

Center pane
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Table 4-1 Web parts on the HP Client Manager Home page (continued)

DescriptionWeb part

Contains the Web parts that provide an overview of the health of your HP computers.

The following Web parts are available:

■ HP Asset Change Alerts
■ HP Threshold Alerts
■ HP Hardware Health Alerts

Each of these Web parts can display 100 alerts.

Right pane

Contains the EventConsole Web part, which provides a consolidated view of device health
across your network.

For more information, see the topics about alerts and alert management in the Symantec
Management Platform Help.

Bottom pane

About the predefined filters in HP Client Manager
A resource filter, usually known as a filter, is a dynamic definition of a set of
resources. The resources can be organized in groups, which are based on certain
criteria such as the operating system. For example, a filter might contain all
Windows XP computers or all computers that have the Altiris Agent installed.
Filters are used as the resource targets for tasks and policies.

Filters replace the collections that were used in HP Client Manager 6.x and
Notification Server 6.x.

HP Client Manager contains many predefined filters, which define the groups of
computers that you are most likely to target for specific management tasks. When
you select target computers in a task or policy, you can use and re-use the
predefined filters or you can build new filters.

You can also view the contents of the HP Client Manager filters to obtain
information about your managed HP computers. For example, you can view the
HP computers that have been discovered or the computers that have the HP Instant
Support Diagnostic tool installed.

See “Viewing the predefined filters in HP Client Manager” on page 65.

For more information, see the topics about resource filters and about specifying
the targets of a policy or task in the Symantec Management Platform Help.
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Viewing the predefined filters in HP Client Manager
HP Client Manager contains many predefined filters that group HP client
computers by criteria such as the computer type. You can view the contents of
the HP Client Manager filters to obtain information about your managed HP
computers. For example, you can view the HP computers that have been discovered
or the computers that have the HP Instant Support Diagnostic tool installed.

See “About the predefined filters in HP Client Manager” on page 64.

To view the predefined filters for view HP Client Manager

1 In the Symantec Management Console, take one of the following actions:

■ On the Manage menu, click Filters, and then in the left pane, expand HP
Client Manager Filters.

■ On the Settings menu, click All Settings, and in the left pane, expand
Agents/Plug-ins > HP Client Manager Agent.

2 Click a filter to view the resources that are represented in that filter.

3 Click Update membership.

4 When you finish viewing the filters, you can go to a different page.

Scheduling and selecting target computers in an HP
Client Manager task

HP Client Manager uses the task management component of the Symantec
Management Platform.

A single task can have multiple schedules or instances, which lets you run the
task on different computers at different times. For example, if you manage
computers in multiple locations, you can set up separate tasks to run at a different
time in each location.

For more information, see the topics about adding a schedule in the Symantec
Management Platform Help.

HP Client Manager contains several predefined tasks that let you perform
management tasks. Some of these tasks have a default schedule that automatically
runs the task at a set interval, such as once a week. You can use the default schedule
or configure a new schedule for those tasks.

Most of the predefined tasks also contain a default filter to help you select the
correct targets for each specific task.

See “Viewing the predefined filters in HP Client Manager” on page 65.
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To schedule and select target computers in an HP Client Manager task

1 In the Symantec Management Console, open the task for editing.

2 On the task page, under Task Status, take any of the following actions:

Lets you reschedule that instance of the task.

In the ModifyTaskSchedule dialog box, select the scheduling
options and select one or more targets, and then click OK.

You might want to reschedule an existing instance if the task
failed due to an incorrect setting. In that case, you can fix the
setting and reschedule the task instead of creating a new task.

Some tasks cannot be rescheduled.

Double-click an
existing task in the
list.

Lets you run the task or policy as soon as possible on one
selected target, unless it must wait for a maintenance window.

In the Quick Run Now dialog box, select the target, and then
click Run.

This option is not available for some tasks.

Click Quick Run.

Lets you schedule the task or policy to run at a specific time.

In the NewSchedule dialog box, define the schedule, and then
click Schedule.

Click New Schedule.

3 (Optional) To create multiple schedules for this task, repeat step 2 for each
additional schedule.

4 When you finish scheduling the task, you can close the task page.

Viewing the HP Client Manager reports
When information is collected from your managed HP computers, it is sent to the
Notification Server computer and stored in a central database. HP Client Manager
contains predefined reports, which display this information to help you analyze
your data. You can view these reports from a Web browser.

To view the HP Client Manager reports

1 In the Symantec Management Console, on the Reports menu, click All
Reports.

2 In the left pane, click Reports > HP Client Manager.

3 Expand the HPClientManager folder, expand a subfolder, and then select a
report.
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4 When the report appears in the right pane, click Refresh to display the latest
information.

5 If the report page contains a Parameters section, you can select additional
ways to organize and display the information.

After you select new parameters, click Refresh.

6 (Optional) You can print the report or save it in a variety of formats. Other
actions might be available depending on the type of report.

Viewing the Microsoft Windows 7 readiness reports
HP Client Manager 7.0 SP2 and later supports Microsoft Windows 7 operating
systems on HP client computers.

HP Client Manager supports the following editions of Windows 7:

■ Windows 7 Enterprise 32-bit and 64-bit

■ Windows 7 Professional 32-bit and 64-bit

■ Windows 7 Ultimate 32-bit and 64-bit

For more information about the system requirements for HP Client Manager, see
the latest HP Client Manager Release Notes. You can search for the release notes
in the Altiris Knowledgebase, which is located at the following URL:

http://kb.altiris.com/

The Windows 7 readiness reports help you gather information about the Windows
7 readiness of your HP client computers. You can run, view, or schedule any of
the Windows 7 readiness reports.

For more information, see the topics about viewing and managing resource data
with reports in the Symantec Management Platform Help.

To view the Windows 7 readiness reports

1 In the Symantec Management Console, on the Reports menu, click All
Reports.

2 In the left pane, click Reports>HPClientManager>Windows7Ready, and
then select a report.

3 When the report appears in the right pane, click Refresh to display the latest
information.
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4 If the report page contains a Parameters section, you can select additional
ways to organize and display the information.

After you select new parameters, click Refresh.

5 (Optional) You can print the report or save it in a variety of formats. Other
actions might be available depending on the type of report.

About platform tasks in HP Client Manager
HP Client Manager uses several tasks that originate in the Symantec Management
Platform.

Table 4-2 Platform tasks in HP Client Manager

DescriptionTask

Identifies all the HP computers in your network as well as the
computers that HP Client Manager does not support.

This task is a step in the process for setting up HP Client Manager.

See “Discovering HP client computers” on page 55.

Discover HP Computers

Automatically installs the HP Instant Support Diagnostics tool
on all the managed HP client computers that have the HP Client
Manager Agent.

This tool is required before you can run the HP Instant Support
diagnostics on HP client computers.

See “Installing the HP Instant Support Diagnostics tool”
on page 137.

HP Instant Support
Diagnostics Install

Gathers general inventory data from managed non-HP computers.

You can use this data to track and analyze different aspects of
your non-HP computers.

See “Gathering the client computer inventory” on page 71.

Non HP Client
Inventory

Performs automatic, remote backups of your managed HP
computers.

If an HP client computer suffers a data loss, you can restore its
data from the backup.

See “Performing an HP backup” on page 147.

HP Backup
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Gathering client computer
inventory

This chapter includes the following topics:

■ About client computer inventory

■ Gathering the client computer inventory

■ Viewing the client computer inventory reports

■ Viewing client computer inventory data in the Resource Manager

About client computer inventory
HP Client Manager lets you gather extensive inventory data from your managed
HP computers. You can use this data to track and analyze different aspects of
your HP computers. The more information you have about each computer, the
better you can manage it.

Because many networks contain computers from multiple manufacturers, HP
Client Manager can also gather general inventory data from managed non-HP
computers.

Some of the data that is gathered from HP computers is as follows:

■ Computer name and type

■ System manufacturer, product name, description, and classification

■ BIOS vendor and version

■ System ID

■ Serial number
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■ HP SKU number

■ IP address

■ Operating system name

■ CPU processor name and speed

■ Battery and chassis details

■ Total memory

■ Language

■ Storage device details

■ Embedded Security support

HP Client Manager contains predefined tasks to gather inventory data from HP
client computers and non-HP client computers. By default, the tasks run once a
week. You can skip these tasks unless you need to run them on a different schedule
or on a different group of computers.

See “Gathering the client computer inventory” on page 71.

The inventory data for client computers is added to each computer’s resource
record in the CMDB (Configuration Management Database).

After the inventory data is gathered, you can view it in the following places:

Lets you view and analyze the inventory data for all the client
computers.

See “Viewing the client computer inventory reports” on page 71.

Inventory reports

Lets you view detailed inventory information for a specific client
computer.

See “Viewing client computer inventory data in the Resource
Manager” on page 72.

Resource Manager

Examples of how you can use the inventory data are as follows:

■ Quickly check on the kinds of computers your organization has. You can check
by serial numbers, asset tags, and other criteria.

■ Sort computers by criteria such as CPU speed, memory, or storage device.

■ Determine how many systems of a particular HP SKU number your organization
has purchased.

Gathering client computer inventory
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Gathering the client computer inventory
HP Client Manager lets you gather inventory data from your managed HP
computers and non-HP computers.

See “About client computer inventory” on page 69.

To gather the inventory data, you can use the following predefined tasks:

Runs on the computers that are in the filter Computers with HP
Client Manager Agent Installed.

HP Client Inventory

Runs on the computers that are in the filter All Unsupported HP
Client Manager Computers.

Non HP Client
Inventory

By default, these tasks run once a week. You can skip these tasks unless you need
to run them on a different schedule or on a different group of computers.

To view or configure the client computer inventory tasks

1 On the HP Client Manager Home page, under Management Tasks, click
Inventory, and then click one of the following tasks:

■ HP Client Inventory

■ Non HP Client Inventory

See “Accessing the HP Client Manager Home page” on page 62.

2 On the task page, under Task Status, you can view the details of an existing
task instance, run the task, or create a new schedule.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

3 When you finish viewing or scheduling the task, you can close the task page.

Viewing the client computer inventory reports
The client computer inventory reports let you view and analyze the inventory
data that is gathered from your managed HP computers. A report that lets you
view inventory data from non-HP client computers is also available.

See “About client computer inventory” on page 69.

See “Gathering the client computer inventory” on page 71.

For more information, see the topics about viewing and managing resource data
with reports in the Symantec Management Platform Help.
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To view the HP client computer inventory reports

1 On the HP Client Manager Home page, under Management Tasks, click
Inventory > View HP Client Inventory Reports.

See “Accessing the HP Client Manager Home page” on page 62.

2 In the new window that opens, in the left pane, under HP Client Inventory,
click a report.

3 To display the latest information, in the right pane, click Refresh.

4 To view additional details, in the right pane, under Parameters, select a
different option in Information Category, and then click Refresh.

5 (Optional) You can print the report or save it in a variety of formats. Other
actions might be available depending on the type of report.

To view the non-HP client computer inventory report

1 In the SymantecManagementConsole, on the Reports menu, click HPClient
Manager > View All Reports.

2 In the left pane, click Reports > HP Client Manager > Non Supported
Computers > Non Supported Computer Information.

3 To display the latest information, in the right pane, click Refresh.

4 To view additional details, in the right pane, under Parameters, select a
different option in Information Category, and then click Refresh.

5 (Optional) You can print the report or save it in a variety of formats. Other
actions might be available depending on the type of report.

Viewing client computer inventory data in the
Resource Manager

When you gather inventory data for client computers, the data is added to each
computer’s resource record in the CMDB (Configuration Management Database).
The Resource Manager in the Symantec Management Platform provides views of
the data in the CMDB. You can use the Resource Manager to view the detailed
inventory information for your managed HP computers.

See “About client computer inventory” on page 69.

See “Gathering the client computer inventory” on page 71.

To view HP client computer inventory data in the Resource Manager

1 To access the Resource Manager window, take one of the following actions:
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In the report view, select a computer and click Actions >
Resource Manager.

From a report

■ In the Symantec Management Console, on the Manage
menu, click Resource.

■ In the Select Resource dialog box, select a computer and
then click OK.

If another type of resource is listed, in Group, select
Resource > Asset > Network Resource > Computer.

From a list of
resources

■ In the Symantec Management Console, on the Manage
menu, click Filter.

■ In the left pane, click Filters>HPClientManagerFilters,
and then select a filter from the list.

■ In the right pane, click a computer in the list, and then
click Actions > Resource Manager.

From a filter

2 In the Resource Manager window, on the View menu, click Inventory.

3 In the center pane, expand Data Classes > HP Client Manager Inventory.

4 Select one of the nodes that begin with HPCMS.

5 When you finish viewing the data, you can close the Resource Manager
window.
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Managing TPM (Trusted
Platform Module) devices
on HP computers

This chapter includes the following topics:

■ About HP Embedded Security

■ About Embedded Security tasks and the HP Embedded Security Wizard

■ Default filters for the Embedded Security tasks

■ Initializing Embedded Security on HP client computers

■ Creating a Configure Embedded Security task

■ Configure Embedded Security task page

■ Manage Embedded Security Credential task page

■ Changing the Embedded Security owner’s password

■ Resetting an Embedded Security user’s password

■ Creating a token for resetting an Embedded Security user’s password

■ Creating a task to reset an Embedded Security user’s password

■ Archiving Embedded Security credentials and settings

■ Restoring Embedded Security credentials and settings

■ Viewing the Embedded Security reports
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About HP Embedded Security
HP Embedded Security protects against unauthorized access to user data or
credentials on the client computer. Embedded Security is a module in the HP
ProtectTools Security Manager software. Embedded Security support is provided
through a hardware security chip that is embedded in some models of HP
computers. The chip is called the Trusted Platform Module (TPM).

You can remotely manage any TPM devices that are present on your managed HP
computers. HP Client Manager lets you create the tasks that perform the
management actions on the client computers. This method of managing the TPM
does not require the physical presence of the IT administrator at the client
computer. The management tasks include enabling the TPM devices, setting
passwords, changing and resetting passwords, and archiving and restoring
credential data.

See “About Embedded Security tasks and the HP Embedded Security Wizard”
on page 76.

The Embedded Security reports let you view and analyze the Embedded Security
data that is gathered from your managed HP computers. The information about
a client computer’s support of Embedded Security is gathered during the client
computer inventory process.

See “About client computer inventory” on page 69.

See “Viewing the Embedded Security reports” on page 92.

For more information about how Embedded Security works, see theHPProtectTools
Security Manager Guide for each HP computer model. This guide is available in
the sections for specific computer models on the HP Web site, which is at the
following URL:

http://www.hp.com/

AboutEmbeddedSecurity tasksand theHPEmbedded
Security Wizard

You can remotely manage any TPM (Trusted Platform Module) devices that are
present on your managed HP computers.

See “About HP Embedded Security” on page 76.

HP Client Manager provides the Embedded Security tasks that let you perform
the following management actions:

■ Initialize the Embedded Security on the HP client computers.

Managing TPM (Trusted Platform Module) devices on HP computers
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This action initializes the TPM chip, sets the owner password, restarts the
computer, and prompts the user to create a password.
See “Initializing Embedded Security on HP client computers” on page 78.

■ Change the owner password.
The owner is the administrator who can manage the Embedded Security on
the client computers. The owner password is required to perform critical
administrative tasks on the TPM chip. HP recommends the use of strong
passwords.
See “Changing the Embedded Security owner’s password” on page 84.

■ Reset a user’s password.
This password lets the user access the Embedded Security features on their
computer. The password reset process lets you reset the user’s password
without seeing the password yourself.
See “Resetting an Embedded Security user’s password” on page 85.

■ Archive and restore the credentials and settings on the client computers.
See “Archiving Embedded Security credentials and settings” on page 89.
See “Restoring Embedded Security credentials and settings” on page 90.

The HP Embedded Security Wizard helps you quickly create and schedule the
Embedded Security tasks. You can also create new tasks by cloning existing
Embedded Security tasks. However, we recommend that you use the wizard to
create the tasks because it pre-selects the correct computer filter for each task.

See “Default filters for the Embedded Security tasks” on page 77.

Default filters for the Embedded Security tasks
HP Client Manager contains many predefined filters, which define the groups of
computers that you are most likely to target for specific management tasks. By
default, each Embedded Security task targets a predefined filter that is most
appropriate for that task. You can select any filter, group, or computer for an
Embedded Security task. However, we recommend that you select the default
filter to ensure that the task is executed properly.

See “About the predefined filters in HP Client Manager” on page 64.

See “Viewing the predefined filters in HP Client Manager” on page 65.
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Table 6-1 Default filters for the Embedded Security tasks

Default target filterOptionTask

Computers without Embedded Security
initialized

Not applicableConfigure Embedded Security

See “Initializing Embedded Security on HP
client computers” on page 78.

Computers with Embedded Security
initialized

Not applicableModify security Owner password

See “Changing the Embedded Security
owner’s password” on page 84.

Computers without Embedded Security Reset
Password token file created

Create password
reset token file

Manage security User passwords (Reset user
passwords)

See “Creating a token for resetting an
Embedded Security user’s password”
on page 86.

Computers with Embedded Security Reset
Password token file created

Reset security User
password

Manage security User passwords (Reset user
passwords)

See “Creating a task to reset an Embedded
Security user’s password” on page 88.

Computers without Embedded Security
archived

ArchiveManage security credentials and settings

See “Archiving Embedded Security
credentials and settings” on page 89.

Computers with Embedded Security archivedRestoreManage security credentials and settings

See “Archiving Embedded Security
credentials and settings” on page 89.

InitializingEmbeddedSecurity onHPclient computers
HP Embedded Security support is provided through a hardware security chip that
is embedded in some models of HP computers. The chip is called the Trusted
Platform Module (TPM). HP Client Manager lets you remotely initialize Embedded
Security on the managed computers.

We recommend that you initialize Embedded Security immediately after setting
up the HP client computers and HP Client Manager. The initialization reduces the
risk that an unauthorized user, a computer worm, or a virus might gain access to
the computer.

See “About HP Embedded Security” on page 76.

Managing TPM (Trusted Platform Module) devices on HP computers
Initializing Embedded Security on HP client computers

78



For HP Client Manager to support Embedded Security on a managed HP computer,
the managed computer must meet the following requirements:

■ The client computer must have a BIOS administrator password.

■ The Embedded Security chip must be enabled in the BIOS.

■ The Embedded Security software must be installed on the client computer.

Table 6-2 Process for initializing Embedded Security on HP client computers

DescriptionActionStep

The Configure Embedded Security task enables the TPM chip, sets the
owner password, and initializes the user.

The owner is the administrator who can manage the Embedded Security
on the client computers.

See “Creating a Configure Embedded Security task” on page 79.

After the task runs on the client computer, the computer restarts.

In HP Client Manager,
the administrator
creates and runs a
Configure Embedded
Security task.

Step 1

During the client computer restart, the user is prompted to press F1 to
prove their physical presence. When the restart is complete, the user opens
HP ProtectTools Security Manager and uses the UserInitializationWizard
to create their user password.

For more information, see the documentation or help that is provided with
HP ProtectTools Security Manager.

On the client computer,
the Embedded Security
user creates their
password.

Step 2

The Manage Embedded Security Credential task creates a backup of the
Embedded Security credentials and settings on the HP client computers.
The backup includes the passwords of the owner and the Embedded Security
users that are initialized on each client computer.

We recommend that you archive the credentials every time you perform
an initialization.

See “Archiving Embedded Security credentials and settings” on page 89.

(Optional) In HP Client
Manager, the
administrator archives
the Embedded Security
credentials.

Step 3

Creating a Configure Embedded Security task
The Configure Embedded Security task enables the TPM (Trusted Platform Module)
chip on the managed HP computers that have the chip. The task also sets the
owner password and initializes the Embedded Security users.

When you create this type of task with the Embedded Security Wizard, the task
is named Configure Embedded Security, followed by the creation date and time.
After the task is created, you can edit the name and make other changes on the
Configure Embedded Security task page.
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See “Configure Embedded Security task page” on page 81.

This task is a step in the process for initializing Embedded Security on HP client
computers. After the task runs on the client computers, the computers restart
and the users must create their passwords.

See “Initializing Embedded Security on HP client computers” on page 78.

To initialize Embedded Security

1 On the HP Client Manager Home page, under Management Tasks, click
Embedded Security > HP Embedded Security Wizard.

See “Accessing the HP Client Manager Home page” on page 62.

2 In the Embedded Security Wizard, on the Choose Embedded Security task
page, click Initialize Embedded Security.

3 To let the user accept or reject the initialization, click Allow user to reject
initialization.

If this option is not selected, the user can only accept the initialization.

4 On the Choose Embedded Security task page, click Next.

5 On the ConfigureEmbeddedSecuritytask page, type the following passwords:

Lets you access the BIOS to initialize the Embedded Security.

This password must be the same as the BIOS administrator
password that is set on the target computers.

BIOS Administrator
password

Provides the ability to manage the Embedded Security on the
client computers.

This password is used to initialize the owner on the target
computers. Retype this password to confirm it.

Owner password

6 On the Configure Embedded Security task page, click Next.

7 On the Computer Collections page, select the target computers, and then
click Next.

We recommend that you select the default filter, which is Computerswithout
Embedded Security initialized.

Warning: If you select different computers and then back up and change the
type of task, the new target computers remain selected for the new task.

Managing TPM (Trusted Platform Module) devices on HP computers
Creating a Configure Embedded Security task

80



8 On the Schedule Task page, specify when to run the task.

You can run the task immediately or create a schedule on which to run the
task.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

9 When you finish scheduling the task, click Finish.

Configure Embedded Security task page
This page represents a Configure Embedded Security task, which enables the TPM
chip (Trusted Platform Module) on managed HP computers. The task also sets the
owner password and initializes the Embedded Security users.

A Configure Embedded Security task is created when you use the HP Embedded
Security Wizard or when you clone an existing Configure Embedded Security
task. We recommend that you use the wizard to create this type of task.

The options on this page are similar to those that appear in the HP Embedded
Security Wizard when you select the Initialize Embedded Security option.

You can access a Configure Embedded Security task from the Manage menu, under
Jobs and Tasks.

See “Creating a Configure Embedded Security task” on page 79.

Table 6-3 Options on the Configure Embedded Security task page

DescriptionOption

Provides the ability to manage the Embedded Security on the
client computers.

Owner password

Lets you access the BIOS to initialize and manage the Embedded
Security.

This password must be the same as the BIOS administrator
password that is set on the target computers.

BIOS Administrator
password

Lets you allow the users to accept or reject the initialization on
their client computers.

Allow user to reject
initialization

Lets you schedule the task and select the target computers on
which to run it.

See “Scheduling and selecting target computers in an HP Client
Manager task” on page 65.

Task Status section
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Manage Embedded Security Credential task page
This page represents a Manage Embedded Security Credential task, which can
manage, archive, and restore the owner password and user passwords on managed
HP computers.

A Manage Embedded Security Credential task is created when you use the HP
Embedded Security Wizard or when you clone an existing Manage Embedded
Security Credential task. We recommend that you use the wizard to create this
type of task.

The options on this page are similar to those that appear in the HP Embedded
Security Wizard when you select any option except the initialization option.

You can access a Manage Embedded Security Credential task from the Manage
menu, under Jobs and Tasks.

The Manage Embedded Security Credential task page contains the following
sections:

Contains the options for all the actions that this type of task can
perform.

You can select an option that is different from the one that you
selected in the HPEmbeddedSecurityWizard. When you select
a different option, you must specify a schedule and the target
computers. A new instance of this task is created. The task itself
retains its original options.

See Table 6-4.

Select the type of task
to run section

Lets you schedule the task and select the target computers on
which to run it.

See “Scheduling and selecting target computers in an HP Client
Manager task” on page 65.

Task Status section

A Manage Embedded Security Credential task can perform any of several actions,
depending on the options that you select.
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Table 6-4 Options in the Select the type of task to run section

DescriptionSub-optionOption

Lets you change the Embedded Security owner password on a group
of HP client computers.

When you select this option, you must specify the following
passwords:

■ Current owner password
■ New owner password

See “Changing the Embedded Security owner’s password”
on page 84.

Not applicableModifysecurityowner
password

Lets you create the token file that is required to reset an Embedded
Security user’s password.

When you select this option, you must specify a Reset token
password.

See “Creating a token for resetting an Embedded Security user’s
password” on page 86.

Create password
reset token file

Manage security user
password (reset user
password)

Lets you reset an Embedded Security user’s password.

When you select this option, you must specify the following
information:

■ User(domain\user)
Lets you type the domain and name of the user whose password
you need to reset.

■ Reset token password
This password must be the same as the one that was used to
create the password reset token file.

See “Creating a task to reset an Embedded Security user’s password”
on page 88.

Reset security user
password

Manage security user
password (reset user
password)

Lets you back up the credentials of the Embedded Security owner
and users for a specific group of HP client computers.

When you select this option, you must specify the following
passwords:

■ Owner password
■ Recovery Token password

See “Archiving Embedded Security credentials and settings”
on page 89.

ArchiveManage security
credentials and
settings
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Table 6-4 Options in the Select the type of task to run section (continued)

DescriptionSub-optionOption

Lets you restore the credentials of the Embedded Security owner
and users for a specific group of HP client computers.

When you select this option, you must specify the following
passwords:

■ Owner password
■ Recovery Token password

This password must be the same as the one that was used to
create the archive.

See “Restoring Embedded Security credentials and settings”
on page 90.

RestoreManage security
credentials and
settings

Changing the Embedded Security owner’s password
The HP Embedded Security owner is the administrator who can manage the
Embedded Security on the client computers. The owner’s password is required to
perform critical administrative tasks on the TPM chip. This password must be
changed at regular intervals for security purposes.

HP Client Manager lets you create a task to change your owner password.

When you create this type of task with the Embedded Security Wizard, the task
is named Manage Embedded Security Credential, followed by the creation date
and time. After the task is created, you can edit the name and make other changes
on the Manage Embedded Security Credential task page.

See “Manage Embedded Security Credential task page” on page 82.

To change the Embedded Security owner’s password

1 On the HP Client Manager Home page, under Management Tasks, click
Embedded Security > HP Embedded Security Wizard.

2 In the Embedded Security Wizard, on the Choose Embedded Security task
page, click Modify security Owner password, and then click Next.

3 On the Configure Embedded Security task page, take the following actions:

■ Type the Current owner password.

■ Type the New owner password, and then retype it to confirm it.

■ Click Next.
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4 On the Computer Collections page, select the target computers, and then
click Next.

We recommend that you select the default filter, which is Computers with
Embedded Security initialized.

Warning: If you select different computers and then back up and change the
type of task, the new target computers remain selected for the new task.

5 On the Schedule Task page, specify when to run the task.

You can run the task immediately or create a schedule on which to run the
task.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

6 When you finish scheduling the task, click Finish.

Resetting an Embedded Security user’s password
To access the Embedded Security features on an HP client computer, a user needs
a password. HP Client Manager lets an Embedded Security owner (administrator)
reset the user’s password without seeing the password. Although the administrator
can reset the password remotely, the password reset process requires the user’s
participation at the client computer.

Table 6-5 Process for resetting an Embedded Security user’s password

DescriptionActionStep

Typically, the user initiates the password reset process when they forget
a password or have problems with the authentication device.

The user requests a new
password.

Step 1

The administrator uses the Embedded Security Wizard to create a task
that sets the token password and creates the token file on the client
computer.

When the task runs on the client computer, it enables the CreatePassword
Reset Token option within HP ProtectTools.

See “Creating a token for resetting an Embedded Security user’s password”
on page 86.

In HP Client Manager,
the Embedded Security
administrator creates a
password reset token
and sends it to the
client computer.

Step 2
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Table 6-5 Process for resetting an Embedded Security user’s password
(continued)

DescriptionActionStep

Typically, the administrator provides instructions to the user for performing
this step, either by telephone, email, or some other method.

After the reset token task runs, a dialog box appears on the client computer.
The dialog box contains a link that the user clicks to open the HP
ProtectTools software.

In HP ProtectTools, the user uses the Password Reset feature to enable the
PasswordResetforcurrentuser option. This option lets the administrator
reset the user’s password.

For more information about using HP ProtectTools, see the documentation
or help that is provided with HP ProtectTools Security Manager.

On the client computer,
the user authorizes the
administrator to reset
their user password.

Step 3

After the user enables the password reset, the administrator creates a task
to reset that user’s password. The administrator must supply the same
token password that was used to create the password reset token.

See “Creating a task to reset an Embedded Security user’s password”
on page 88.

In HP Client Manager,
the Embedded Security
administrator resets the
user’s password.

Step 4

See “About HP Embedded Security” on page 76.

Creating a token for resetting an Embedded Security
user’s password

When an Embedded Security user forgets a password or has problems with the
authentication device, you can reset the password. Before you reset the user’s
password, you must create a password reset token file. HP Client Manager lets
you create a task to set the token password and create the token file on the client
computer.

This task performs the following actions on the client computer:

■ Creates a password reset token file.

■ Displays a dialog box that the user clicks to open the HP ProtectTools software
and enable the password reset.

When you create this type of task with the Embedded Security Wizard, the task
is named Manage Embedded Security Credential, followed by the creation date
and time. After the task is created, you can edit the name and make other changes
on the Manage Embedded Security Credential task page.
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See “Manage Embedded Security Credential task page” on page 82.

This task is a step in the process for resetting user passwords in Embedded
Security.

See “Resetting an Embedded Security user’s password” on page 85.

To create a token for resetting an Embedded Security user’s password

1 On the HP Client Manager Home page, under Management Tasks, click
Embedded Security > HP Embedded Security Wizard.

2 In the Embedded Security Wizard, on the Choose Embedded Security task
page, click Create Password Reset Token file, and then click Next.

3 On the Configure Embedded Security task page, take the following actions:

■ Click Create password reset token file.

■ Type a Reset token password and then retype the password to confirm
it.
This password is required when you create the task to reset the password.

■ Click Next.

4 On the Computer Collections page, select the target computers, and then
click Next.

We recommend that you select the default filter, which is Computerswithout
Embedded Security Password token file created. If you need to reset a
password for a specific user, then specify that user’s computer.

Warning: If you select different computers and then back up and change the
type of task, the new target computers remain selected for the new task.

5 On the Schedule Task page, specify when to run the task.

You can run the task immediately or create a schedule on which to run the
task.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

6 When you finish scheduling the task, click Finish.
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Creating a task to reset an Embedded Security user’s
password

When an Embedded Security user forgets a password or has problems with the
authentication device, you can reset the password.

This task is a step in the process for resetting Embedded Security user passwords.

See “Resetting an Embedded Security user’s password” on page 85.

Before you reset a password, the user must enable the password reset on the client
computer.

See “Creating a token for resetting an Embedded Security user’s password”
on page 86.

After the user enables the password reset, you can create a task to reset that user’s
password. If you create and send the task without the user’s authorization, the
task fails.

When you create this type of task with the Embedded Security Wizard, the task
is named Manage Embedded Security Credential, followed by the creation date
and time. After the task is created, you can edit the name and make other changes
on the Manage Embedded Security Credential task page.

See “Manage Embedded Security Credential task page” on page 82.

To reset an Embedded Security user’s password

1 On the HP Client Manager Home page, under Management Tasks, click
Embedded Security > HP Embedded Security Wizard.

2 In the Embedded Security Wizard, on the Choose Embedded Security task
page, click Manage security User passwords (Reset user passwords), and
then click Next.

3 On the Configure Embedded Security task page, take the following actions:

■ Click Reset security User password.

■ Type the name of the user whose password you need to reset. Use the
following format:
domain\user

■ Type the Reset token password.
Type the same token password that was used to create the password reset
token.

■ Click Next.
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4 On the Computer Collections page, select the target computers, and then
click Next.

We recommend that you select the default filter, which is Computers with
Embedded Security Reset Password token file created.

Warning: If you select different computers and then back up and change the
type of task, the new target computers remain selected for the new task.

5 On the Schedule Task page, specify when to run the task.

You can run the task immediately or create a schedule on which to run the
task.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

6 When you finish scheduling the task, click Finish.

ArchivingEmbeddedSecurity credentials and settings
You can archive the Embedded Security credentials and settings for the owner
and users that are initialized on one or more HP client computers. The archived
data is saved in the CMDB (Configuration Management Database). We recommend
that you archive the Embedded Security data on a regular schedule and every
time you perform an initialization. If a loss of the archived data occurs, you can
restore it.

See “Restoring Embedded Security credentials and settings” on page 90.

HP Client Manager lets you create a task to archive the Embedded Security data
for HP client computers.

When you create this type of task with the Embedded Security Wizard, the task
is named Manage Embedded Security Credential, followed by the creation date
and time. After the task is created, you can edit the name and make other changes
on the Manage Embedded Security Credential task page.

See “Manage Embedded Security Credential task page” on page 82.

To archive Embedded Security credentials and settings

1 On the HP Client Manager Home page, under Management Tasks, click
Embedded Security > HP Embedded Security Wizard.

2 In the Embedded Security Wizard, on the Choose Embedded Security task
page, click Manage security credentials and settings, select Archive from
the list, and then click Next.
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3 On the ConfigureEmbeddedSecuritytask page, type the following passwords:

This password is required to create an archive.Owner password

Create a password that can be used to restore this archive in
the future. Retype this password to confirm it.

Recovery token
password

4 On the Configure Embedded Security task page, click Next.

5 On the Computer Collections page, select the target computers, and then
click Next.

We recommend that you select the default filter, which is Computerswithout
Embedded Security archived.

Warning: If you select different computers and then back up and change the
type of task, the new target computers remain selected for the new task.

6 On the Schedule Task page, specify when to run the task.

You can run the task immediately or create a schedule on which to run the
task.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

7 When you finish scheduling the task, click Finish.

RestoringEmbeddedSecurity credentials andsettings
You can restore any Embedded Security credentials and settings that have been
archived. The archived data is saved in the CMDB (Configuration Management
Database).

See “Archiving Embedded Security credentials and settings” on page 89.

HP Client Manager lets you create a task to restore the Embedded Security data
from the CMDB to the HP client computers.

When you create this type of task with the Embedded Security Wizard, the task
is named Manage Embedded Security Credential, followed by the creation date
and time. After the task is created, you can edit the name and make other changes
on the Manage Embedded Security Credential task page.

See “Manage Embedded Security Credential task page” on page 82.

The restoration task performs the following actions on the client computers:
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■ Restores the owner’s credentials and settings.

■ Prepares the users’ credentials and settings for restoration.
This preparation is done for only those users whose Embedded Security
credentials and settings have been archived.

■ Prompts the users to complete the restoration in the HP ProtectTools Security
Manager software.
For more information about using HP ProtectTools, see the documentation or
help that is provided with HP ProtectTools Security Manager.

To restore Embedded Security credentials and settings

1 On the HP Client Manager Home page, under Management Tasks, click
Embedded Security > HP Embedded Security Wizard.

2 In the Embedded Security Wizard, on the Choose Embedded Security task
page, click Manage security credentials and settings, select Restore from
the list, and then click Next.

3 On the ConfigureEmbeddedSecuritytask page, type the following passwords:

Type the same owner password that was used to create the
archive.

Owner password

Type the same token password that was used to archive the
credentials for this set of computers.

Recovery token
password

4 On the Configure Embedded Security task page, click Next.

5 On the Computer Collections page, select the target computers, and then
click Next.

We recommend that you select the default filter, which is Computers with
Embedded Security archived.

Warning: If you select different computers and then back up and change the
type of task, the new target computers remain selected for the new task.

6 On the Schedule Task page, specify when to run the task.

You can run the task immediately or create a schedule on which to run the
task.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

7 When you finish scheduling the task, click Finish.
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Viewing the Embedded Security reports
The Embedded Security reports let you view and analyze the Embedded Security
data that is gathered from your managed HP computers. The information about
a client computer’s support of Embedded Security is gathered during the client
computer inventory process.

See “About client computer inventory” on page 69.

Examples of how you can use the Embedded Security reports are as follows:

■ List all the computers that have an Embedded Security chip and show the
version of the Embedded Security software that is installed.

■ Show the archive status of the Embedded Security data on the client computers.

■ View the Embedded Security tasks that failed.

For more information, see the topics about viewing and managing resource data
with reports in the Symantec Management Platform Help.

To view the Embedded Security reports

1 On the HP Client Manager Home page, under Management Tasks, click
Embedded Security > View HP Embedded Security Reports.

See “Accessing the HP Client Manager Home page” on page 62.

2 In the left pane, under Embedded Security, select a report.

3 To display the latest information, in the right pane, click Refresh.

4 If the report page contains a Parameters section, you can select additional
ways to organize and display the information. After you select new
parameters, click Refresh.

5 (Optional) You can print the report or save it in a variety of formats. Other
actions might be available depending on the type of report.
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Managing driver and BIOS
updates (SoftPaqs)

This chapter includes the following topics:

■ About HP SoftPaq management

■ Obtaining and delivering HP SoftPaqs

■ About HP Instant Support System Health Scan

■ Performing a System Health Scan

■ Viewing the System Health Scan reports

■ Viewing System Health Scan results in the Resource Manager

■ About downloading HP SoftPaqs

■ Downloading and importing the required HP SoftPaqs

■ Downloading HP SoftPaqs manually

■ About importing HP SoftPaqs

■ About importing HP SoftPaqs with a Windows scheduled task

■ Importing HP SoftPaqs manually

■ Delivering an HP SoftPaq to client computers

■ Editing an HP SoftPaq delivery task

■ Viewing the HP SoftPaq delivery reports
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About HP SoftPaq management
A SoftPaq is a single executable file that contains drivers, BIOS updates, or other
system files for HP computers. SoftPaqs can be downloaded from the HP Web site
and then deployed to multiple computer models or to a specific model.

With HP Client Manager, you can proactively and remotely manage the SoftPaqs
that HP provides to keep your managed HP computers updated and working
properly.

Integration with HP Instant Support System Health Scan lets HP Client Manager
identify the computers that require SoftPaq updates and the SoftPaqs that are
required. This SoftPaq information provides a list of the SoftPaqs that must be
downloaded.

See “About HP Instant Support System Health Scan” on page 96.

You can use scheduled tasks to automate and streamline the SoftPaq process. For
example, you can automate the identification of SoftPaq requirements, the SoftPaq
downloads, and the preparation of SoftPaq files for delivery.

You can also perform the SoftPaq management tasks manually for specific
problems or critical issues.

See “Obtaining and delivering HP SoftPaqs” on page 94.

The information about the health scan results and the SoftPaqs is stored in the
CMDB (Configuration Management Database) on the Notification Server computer.
The downloaded and imported SoftPaqs are saved in the Filestore folder, which
is an allocated storage area on the Notification Server computer.

HP Client Manager uses the software delivery functions of the Symantec
Management Platform to deploy the SoftPaqs to the client computers.

Some of the platform features that the delivery process takes advantage of are as
follows:

■ Checkpoint recovery, which lets you resume downloading a file if interrupted

■ Bandwidth throttling, which lets you control how much bandwidth a download
can use

■ Data to generate reports

Obtaining and delivering HP SoftPaqs
HP Client Manager lets you obtain the latest SoftPaqs that are available from HP
and deploy them to your managed HP computers. A SoftPaq is a single executable
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file that contains drivers, BIOS updates, or other system files that are unique to
HP computers.

See “About HP SoftPaq management” on page 94.

The process of managing SoftPaqs is ongoing because HP releases new SoftPaqs
frequently. To keep your managed HP computers updated with the latest driver
and BIOS information, HP recommends that you check for new SoftPaqs regularly.

Table 7-1 Process for obtaining SoftPaqs and delivering them to HP client
computers

DescriptionActionStep

The HP Instant Support System Health Scan task identifies issues on your
managed HP computers and determines which SoftPaqs are needed to
resolve those issues.

By default, this task runs at 1:30 A.M. daily. However, you can perform the
scan manually at any time.

See “Performing a System Health Scan” on page 97.

Perform a health scan
to identify the SoftPaqs
that are needed.

Step 1

The health scan information includes the HP client computers that have
issues, the issue type and severity, and the SoftPaqs that can resolve the
issues.

You can view the health scan information in the following places:

■ In the HP Instant Support Health Scan reports

Lets you view the health scan information for multiple computers in
several formats.

See “Viewing the System Health Scan reports” on page 98.

■ In the Resource Manager

Lets you view detailed health scan information for a specific HP client
computer.

See “Viewing System Health Scan results in the Resource Manager”
on page 99.

Review the results of
the health scan.

Step 2

The download process copies the required SoftPaq files from the HP Web
site and saves them in the Filestore folder on the Notification Server
computer.

You can download the SoftPaqs in the following ways:

■ Automatically download all the SoftPaqs that the health scan identified.

This method uses the Download HP Health Scan SoftPaqs task, which
also imports the SoftPaqs.

■ Manually download specific SoftPaqs directly from the HP Web site.

See “About downloading HP SoftPaqs” on page 100.

Download the SoftPaqs
to the Filestore.

Step 3
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Table 7-1 Process for obtaining SoftPaqs and delivering them to HP client
computers (continued)

DescriptionActionStep

The import process refreshes the CMDB (Configuration Management
Database) and makes the SoftPaqs available for delivery.

You can skip this step if you used the Download HP Health Scan SoftPaqs
task, because it imports the SoftPaqs automatically.

You can import the SoftPaqs in the following ways:

■ Automatically import all available SoftPaqs on a daily basis.

This method uses a Windows scheduled task to import SoftPaqs at 2:30
A.M. daily, but you can edit the task to change the schedule.

■ Manually run the HP SoftPaq Import task to import any SoftPaqs that
were not imported through another method.

See “About importing HP SoftPaqs” on page 103.

Import the SoftPaqs.Step 4

The HP SoftPaq Delivery Wizard delivers a SoftPaq to the HP client
computers that need it.

Using information from the imported SoftPaq files, the wizard automatically
lists the HP client computers that need that specific SoftPaq.

See “Delivering an HP SoftPaq to client computers” on page 105.

Deliver the SoftPaqs to
the client computers.

Step 5

The HP SoftPaq delivery reports provide information about the SoftPaqs
that were delivered, the computers that received the SoftPaqs, and the
status of the deliveries.

See “Viewing the HP SoftPaq delivery reports” on page 107.

Monitor the HP SoftPaq
deliveries.

Step 6

About HP Instant Support System Health Scan
HP Client Manager is integrated with the HP Instant Support System Health Scan
tool, which analyzes managed HP computers to check their overall health status.
The scan can identify problems, check to see if the latest drivers are installed,
and provide recommendations for resolving potential issues.

The System Health Scan tool is incorporated into the HP Client Manager Agent
that is installed on your managed HP computers. The HP Instant Support System
Health Scan task works with the agent to let you perform the health scans
remotely.

See “Performing a System Health Scan” on page 97.

When the health scan task runs on an HP client computer, it performs or initiates
the following actions:
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■ Delivers the latest known issues to the client computer.

■ Scans the client computer to check the health of its drivers and BIOS and to
determine whether any known issues exist on that computer.

■ Provides possible resolutions to the issues that are found.
This information includes links to the HP support documents that are related
to the issues.
For example, if a computer’s monitor is not configured for optimal performance,
a link is provided to a support page that describes configuring the display.

■ Determines whether a SoftPaq is available to resolve a known issue and
identifies which SoftPaq is needed for that computer.
This information is used to create the list of required SoftPaqs that is used
during the download process.

■ Reports the data to the CMDB (Configuration Management Database) on the
Notification Server computer.
The data is available for viewing with reports or in the Resource Manager.
See “Viewing the System Health Scan reports” on page 98.
See “Viewing System Health Scan results in the Resource Manager” on page 99.

After you perform a scan and review its results, you can take action on the issues
that were found. If SoftPaqs are available to resolve the issues, you can take steps
to obtain and deliver them as needed.

See “Obtaining and delivering HP SoftPaqs” on page 94.

Performing a System Health Scan
The HP Instant Support System Health Scan task identifies issues on your managed
HP computers. It provides possible resolutions to those issues, including a list of
the SoftPaqs that can resolve BIOS and driver issues.

See “About HP Instant Support System Health Scan” on page 96.

By default, this task runs at 1:30 A.M. daily. It runs automatically on all the HP
client computers that have the HP Client Manager Agent installed. Each scan
overwrites the data from the previous scan.

This task is a step in the process for obtaining and delivering HP SoftPaqs.

See “Obtaining and delivering HP SoftPaqs” on page 94.

You can skip this step unless you need to run it on a different schedule or on a
different group of computers.
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To view or modify the System Health Scan task

1 On the HP Client Manager Home page, under Management Tasks, click HP
Instant Support > Perform HP Instant Support Health Scan.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the task page, under Task Status, you can view the details of an existing
task instance, run the task, or create a new schedule.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

3 When you finish viewing or scheduling the task, you can close the task page.

Viewing the System Health Scan reports
The HP Instant Support System Health Scan task scans your managed HP
computers for known issues. It provides information about the computers that
have issues, the issue type and severity, and the actions or SoftPaqs that can
resolve those issues. You can use the System Health Scan reports to view and
analyze the health scan information.

See “About HP Instant Support System Health Scan” on page 96.

Examples of how you can use these reports are as follows:

■ List the computers that have issues and show the recommendations for
resolving the issues, including links to any related HP support documents.

■ Determine the SoftPaqs that are required.

■ Display a bar graph that quickly shows the number of issues by severity.

If these reports are empty, all your HP client computers contain the most recent
SoftPaqs.

This task is a step in the process for obtaining and delivering HP SoftPaqs.

See “Obtaining and delivering HP SoftPaqs” on page 94.

For more information, see the topics about viewing and managing resource data
with reports in the Symantec Management Platform Help.

You can also view health scan information in the Resource Manager.

See “Viewing System Health Scan results in the Resource Manager” on page 99.
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To view the System Health Scan reports

1 On the HP Client Manager Home page, under Management Tasks, click HP
Instant Support > View HP Instant Support Health Scan Reports.

See “Accessing the HP Client Manager Home page” on page 62.

2 In the left pane, under Reports > HP Client Manager > HP Instant Support
System Health Scan, select a report.

3 When the report appears in the right pane, click Refresh to display the latest
information.

4 If the report page contains a Parameters section, you can select additional
ways to organize and display the information.

After you select new parameters, click Refresh.

5 (Optional) You can print the report or save it in a variety of formats. Other
actions might be available depending on the type of report.

Viewing System Health Scan results in the Resource
Manager

The HP Instant Support System Health Scan task scans your managed HP
computers for known issues. It provides information about the computers that
have issues, the issue type and severity, and the actions or SoftPaqs that can
resolve those issues. The health scan data is added to each computer’s resource
record in the CMDB (Configuration Management Database). The Resource Manager
in the Symantec Management Platform provides views of the data in the CMDB.
You can use the Resource Manager to view the health scan information.

See “About HP Instant Support System Health Scan” on page 96.

You can also view health scan information in the System Health Scan reports.

See “Viewing the System Health Scan reports” on page 98.

To view System Health Scan results in the Resource Manager

1 To access the Resource Manager window, take one of the following actions:

In the report view, select a computer and click Actions >
Resource Manager.

From a report
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■ In the Symantec Management Console, on the Manage
menu, click Resource.

■ In the Select Resource dialog box, select a computer and
then click OK.

If another type of resource is listed, in Group, select
Resource > Asset > Network Resource > Computer.

From a list of
resources

■ In the Symantec Management Console, on the Manage
menu, click Filter.

■ In the left pane, click Filters>HPClientManagerFilters,
and then select a filter from the list.

■ In the right pane, click a computer in the list, and then
click Actions > Resource Manager.

From a filter

2 In the Resource Manager window, on the View menu, click Events.

3 In the center pane, expand Data Classes > HP Client Manager Inventory.

4 Click HPCMS ActiveCheckIssueResult.

5 When you finish viewing the data, you can close the Resource Manager
window.

About downloading HP SoftPaqs
The HP Instant Support System Health Scan identifies which of the available
SoftPaqs each managed HP computer needs to resolve its known issues. After you
perform the scan, you can download the SoftPaqs from the HP Web site so that
you can deliver them to the appropriate computers.

This task is a step in the process for obtaining and delivering HP SoftPaqs.

See “Obtaining and delivering HP SoftPaqs” on page 94.

When you download the SoftPaqs, they are saved in the Filestore folder, which
is an allocated storage area on the Notification Server computer. The default path
is as follows:

installation directory\Altiris\Notification Server\NSCap\Bin\Win32

\X86\HPCMS\Filestore

After the download, the SoftPaq files must be imported to prepare them for
delivery.

See “About importing HP SoftPaqs” on page 103.
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Table 7-2 Methods for downloading HP SoftPaqs

DescriptionMethod

The Download HP Health Scan SoftPaqs task downloads the
SoftPaqs to the Filestore and then imports them. It uses the list
of required SoftPaqs that the System Health Scan identified.

This method is the quickest and easiest way to download the
SoftPaqs. It downloads only the SoftPaqs that you need but does
not require you to select them individually. It also eliminates the
import step.

See “Downloading and importing the required HP SoftPaqs”
on page 101.

Automatically
download all the
SoftPaqs that the
System Health Scan
identified.

With this method, you access the HP Web site directly and
download individual SoftPaqs for specific HP computers.

For example, you might use this method to resolve a critical BIOS
issue that the System Health Scan identified on a specific
computer. You can download and install the critical SoftPaq
immediately and then download the SoftPaqs for the other
computers later.

See “Downloading HP SoftPaqs manually” on page 102.

When you use this method, you must import the SoftPaqs.

Manually download
specific SoftPaqs
directly from the HP
Web site.

Downloading and importing the requiredHPSoftPaqs
The Download HP Health Scan SoftPaqs task downloads and imports all the
required SoftPaqs that the System Health Scan identified. It downloads only the
SoftPaqs that you need but does not require you to select them individually.

This task performs the following actions:

■ Downloads the SoftPaqs from the HP Web site to the Filestore folder on the
Notification Server computer.

■ Imports the SoftPaqs, which prepares the SoftPaq files for delivery.
See “About importing HP SoftPaqs” on page 103.

This task is a step in the process for obtaining and delivering HP SoftPaqs.

See “Obtaining and delivering HP SoftPaqs” on page 94.

You can also download individual SoftPaqs directly from the HP Web site.

See “Downloading HP SoftPaqs manually” on page 102.
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To download and import the required HP SoftPaqs

1 On the HP Client Manager Home page, under Administrative Tasks, click
Download HP Health Scan SoftPaqs.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the DownloadHPHealthScanSoftPaqs page, click DownloadSoftPaqs.

If no SoftPaqs are listed, all your HP client computers contain the most recent
SoftPaqs.

Downloading HP SoftPaqs manually
You can go directly to the HP Web site and download the individual SoftPaqs that
are required to resolve issues for specific HP computers. You can obtain
information about which computers require SoftPaq updates from the System
Health Scan reports or from other sources.

Examples of when you might use this download method are as follows:

■ When you need to resolve a critical issue on a specific computer.
You can download the critical SoftPaq immediately without having to download
other SoftPaqs.

■ When firewall restrictions on the Notification Server computer prevent you
from performing downloads on the server.
You can perform the download on a different computer and save the SoftPaqs
to the Filestore folder on the Notification Server computer.

■ When you want to manage the Filestore manually.

This task is a step in the process for obtaining and delivering HP SoftPaqs.

See “Obtaining and delivering HP SoftPaqs” on page 94.

As an alternative to this download method, you can use a task that downloads all
the required SoftPaqs automatically.

See “Downloading and importing the required HP SoftPaqs” on page 101.

After the download, the SoftPaq files must be imported to prepare them for
delivery.

See “About importing HP SoftPaqs” on page 103.
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To manually download and store SoftPaqs

1 Open a browser and go to the HP Support and Drivers Web page at the
following URL:

www.hp.com/support/files

2 Navigate to the software and drivers download page for the SoftPaq that you
need.

3 Download the SoftPaq and save it in the Filestore at the following location:

installation directory\Altiris\Notification Server\NSCap\Bin\Win32

\X86\HPCMS\Filestore

4 Find and download any other SoftPaqs that you need.

5 Close the browser window.

About importing HP SoftPaqs
When SoftPaqs are downloaded from the HP Web site, they are stored in the
Filestore folder on the Notification Server computer. Before SoftPaqs can be
delivered to the HP client computers, they must be imported. The import process
refreshes the CMDB (Configuration Management Database) and makes the SoftPaqs
available for delivery.

This task is a step in the process for obtaining and delivering HP SoftPaqs.

See “Obtaining and delivering HP SoftPaqs” on page 94.

You can skip this step if you used the Download HP health scan SoftPaqs task,
because it imports the SoftPaqs automatically.

See “Downloading and importing the required HP SoftPaqs” on page 101.

Table 7-3 Methods for importing HP SoftPaqs

DescriptionMethod

A Windows scheduled task named NS.HP File Store Update
imports any available SoftPaqs.

This task runs at 2:30 A.M. daily, but you can edit the task to
change the schedule.

See “About importing HP SoftPaqs with a Windows scheduled
task” on page 104.

Automatically on a daily
basis.
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Table 7-3 Methods for importing HP SoftPaqs (continued)

DescriptionMethod

With this method, you use the HP SoftPaq Import task to import
any available SoftPaqs between the times when the scheduled
task runs.

See “Importing HP SoftPaqs manually” on page 104.

Manually import any
SoftPaqs that were not
imported through
another method.

About importing HP SoftPaqs with a Windows
scheduled task

Before SoftPaqs can be delivered to the HP client computers, they must be
imported. The import process refreshes the CMDB (Configuration Management
Database) and makes the SoftPaqs available for delivery.

HP Client Manager installs a Windows scheduled task that automatically imports
all the SoftPaqs that were downloaded but not yet imported. For example, if you
use a different download utility to download the SoftPaqs automatically, you can
run the scheduled task to import them.

By default, the task is scheduled to run at 2:30 A.M. daily, but you can edit the
task to change the schedule.

This task is available on the Windows Control Panel, under Scheduled Tasks >
NS.HP File Store Update.

See “Obtaining and delivering HP SoftPaqs” on page 94.

This task is a step in the process for obtaining and delivering HP SoftPaqs.

Letting the import task run daily helps keep the Filestore current without requiring
an administrator’s involvement. You can perform the import manually when it
is necessary.

See “Importing HP SoftPaqs manually” on page 104.

Importing HP SoftPaqs manually
Before SoftPaqs can be delivered to the HP client computers, they must be
imported. The import process refreshes the CMDB (Configuration Management
Database) and makes the SoftPaqs available for delivery.

Typically, SoftPaqs are imported daily with a Windows scheduled task or when
you perform an automatic SoftPaq download.

See “About importing HP SoftPaqs” on page 103.
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You can use the HP SoftPaq Import task to import all the available SoftPaqs on
demand. Available SoftPaqs are those that were downloaded but not yet imported.

Examples of when you might use this import method are as follows:

■ When you downloaded one or more SoftPaqs directly from the HP Web site
and they were not imported through another method.

■ When you need to resolve a critical issue on a specific computer.
You can import the critical SoftPaq immediately without waiting for the
scheduled import.

This task is a step in the process for obtaining and delivering HP SoftPaqs.

See “Obtaining and delivering HP SoftPaqs” on page 94.

To import HP SoftPaqs manually

1 On the HP Client Manager Home page, under Administrative Tasks, click
HP SoftPaq Import.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the HP SoftPaq Import page, type the full path to the Filestore. The
default path is as follows:

installation directory\Altiris\Notification Server\NSCap\Bin\Win32
\X86\HPCMS\Filestore

3 Click Import.

If the Import option is not available, no SoftPaqs need to be imported.

4 When the import is finished, you can close the page.

Delivering an HP SoftPaq to client computers
The HP SoftPaq Delivery Wizard guides you through the creation of a task that
deploys an HP SoftPaq to one or more groups of managed HP computers. The
wizard lets you select the SoftPaq to deliver and define the schedule for running
the task. Using information from the imported SoftPaq file, the wizard lists the
computers that need the SoftPaq you selected. You can also select additional
computers to deliver to.

To be available for delivery, the SoftPaq must have been downloaded and imported.

See “About downloading HP SoftPaqs” on page 100.

See “About importing HP SoftPaqs” on page 103.

When you complete the SoftPaqDeliveryWizard, it creates the following items:

■ An HP SoftPaq Delivery task.
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The tasks that the wizard creates are given generic names. After a task is
created, you can edit its name and description on the task page.
See “Editing an HP SoftPaq delivery task” on page 106.

■ A package of the SoftPaq files.

■ A policy that initiates when the package is deployed.

■ A filter that contains the computers on which to deploy the SoftPaq.

This task is a step in the process for obtaining and delivering HP SoftPaqs.

See “Obtaining and delivering HP SoftPaqs” on page 94.

To deliver an HP SoftPaq to client computers

1 On the HP Client Manager Home page, under Management Tasks, click
Driver Updates > HP SoftPaq Delivery Wizard.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the ChooseSoftPaqs page, under AvailableHPSoftPaqs, select a SoftPaq.

3 If you selected a BIOS SoftPaq, in Password, type the BIOS setup password.

4 If full volume encryption is enabled on the target computers, select Upgrade
SoftPaq forcefully.

5 On the Choose SoftPaqs page, click Next.

6 On the Choose Computers page, from the list of the computers that require
the selected SoftPaq, select the target computers, and then click Next.

7 On the Choose when to deliver the SoftPaq page, define the schedule for
running the task, and then click Apply.

You can run the task immediately or schedule it to run at a specific time.

8 When the task page appears, you can view or edit the task or close the page.

Editing an HP SoftPaq delivery task
The HP SoftPaq Delivery Wizard guides you through the creation of a task that
delivers and installs SoftPaqs. The tasks that the wizard creates are given generic
names. You might want to change the task names and descriptions.

See “Delivering an HP SoftPaq to client computers” on page 105.

You can also edit an HP SoftPaq Delivery task to revise its schedule.
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To edit an HP SoftPaq delivery task

1 In the SymantecManagementConsole, on the Manage menu, click Jobsand
Tasks.

2 In the left pane, click Jobs and Tasks > Client Tasks > HP Client Manager >
HP SoftPaq Delivery > HP SoftPaq Delivery Tasks, and then select a task.

3 In the right pane, on the task page, to change the task name, click the existing
task name and type the new name.

Repeat this step for the description, which is the line of text that appears
under the task name.

4 Under TaskStatus, you can view the details of an existing task instance, run
the task, or create a new schedule.

5 When you finish viewing or editing the task, you can close the task page.

Viewing the HP SoftPaq delivery reports
After you deliver SoftPaqs to managed HP computers, you can use the HP SoftPaq
delivery reports to monitor the success of the SoftPaq installations. These reports
provide information about the SoftPaqs that were delivered, the computers that
received the SoftPaqs, and the status of the installations.

This task is a step in the process for obtaining and delivering HP SoftPaqs.

See “Obtaining and delivering HP SoftPaqs” on page 94.

For more information, see the topics about viewing and managing resource data
with reports in the Symantec Management Platform Help.

To view the SoftPaq delivery reports

1 On the HP Client Manager Home page, under Management Tasks, click
Driver Updates > View detailed HP Softpaq delivery Reports.

See “Accessing the HP Client Manager Home page” on page 62.

2 In the left pane, under Reports>HPClientManager>HPSoftPaqDelivery,
select a report.

3 When the report appears in the right pane, click Refresh to display the latest
information.
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4 If the report page contains a Parameters section, you can select additional
ways to organize and display the information.

After you select new parameters, click Refresh.

5 (Optional) You can print the report or save it in a variety of formats. Other
actions might be available depending on the type of report.
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Managing the BIO settings
of HP client computers

This chapter includes the following topics:

■ About HP BIOS Settings

■ Modifying the BIOS settings of HP client computers

■ Editing an HP BIOS task

■ Configure HP BIOS Settings pages

■ Creating HP BIOS reports

■ Editing an HP BIOS report

■ Viewing the HP BIOS reports

About HP BIOS Settings
HP Client Manager lets you remotely manage and modify the BIOS and security
settings of your managed HP computers. You can configure a task that deploys
new settings to one or more groups of client computers.

Examples of the settings changes that you can make are as follows:

■ Change the BIOS passwords.

■ Set the chassis intrusion sensor to prompt for a BIOS setup password.

■ Hide the availability of certain ports.

■ Enable or disable the Wake on LAN functionality.

■ Change the BIOS setup language.
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■ Enable Runtime Power Management.

■ Change the boot order of the computer’s devices.

See “Modifying the BIOS settings of HP client computers” on page 110.

The HP BIOS reports let you view and analyze the BIOS data, which is gathered
during the client computer inventory process. You can use the predefined report
and you can create custom reports to filter the BIOS information in different ways.

See “Creating HP BIOS reports” on page 114.

See “Viewing the HP BIOS reports” on page 116.

The HP BIOS data that is available for modification and for reports is gathered
during the client computer inventory process.

Modifying the BIOS settings of HP client computers
The HP BIOS Administration Wizard guides you through the creation of a task
that deploys new BIOS settings to one or more groups of managed HP computers.
The wizard lets you select any number of BIOS settings to modify, select the target
computers, and define the schedule for running the task.

See “About HP BIOS Settings” on page 109.

The tasks that the wizard creates are given generic names. After a task is created,
you can edit its name and description on the task page.

See “Editing an HP BIOS task” on page 111.

To modify the BIOS settings of client computers

1 On the HPClientManagerHome page, under ManagementTasks, click BIOS
Management > HP BIOS Administration Wizard.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the Choose BIOS settings page, select the specific BIOS settings to
configure on the following tabs:

Lets you change the BIOS password and set the common BIOS
settings.

Main tab

Lets you configure the advanced BIOS settings.Advanced tab

Lets you set the device boot order for the client computers
any time they are reset or turned on.

Boot order tab

See “Configure HP BIOS Settings pages” on page 112.
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3 If you have BIOS setup protection, on the Choose BIOS settings page, type
the Current BIOS Setup Password.

This password is required to change the BIOS settings. If the password you
enter does not match the password of the client HP computer, the BIOS
changes are not accepted.

4 On the Choose BIOS settings page, click Allow Numpad to allows the entry
of numeric characters in the BIOS password from the numeric keypad on the
keyboard. Click Next.

5 On the Choosecomputers page, select the computers or resources to run the
task on, and then click Next.

6 On the Choose when to run page, define the schedule for changing the BIOS
settings, and then click Apply.

You can run the task immediately or schedule it to run during off-peak
network hours.

7 When the task page appears, you can view or edit the task or close the page.

Editing an HP BIOS task
The HP BIOS Administration Wizard guides you through the creation of a task
that modifies BIOS settings. The tasks that the wizard creates are given generic
names. To more easily manage your BIOS tasks, you might want to change the
task names and descriptions.

See “Modifying the BIOS settings of HP client computers” on page 110.

You can also edit an HP BIOS task to revise its schedule.

You cannot change the BIOS settings that you selected during the task creation.

To edit an HP BIOS task

1 In the SymantecManagementConsole, on the Manage menu, click Jobsand
Tasks.

2 In the left pane, click Jobs and Tasks > Client Tasks > HP Client Manager >
HP BIOS Administration Tasks, and then select a task.

3 In the right pane, on the task page, to change the task name, click the existing
task name and type the new name.

Repeat this step for the description, which is the line of text that appears
under the task name.
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4 Under TaskStatus, you can view the details of an existing task instance, run
the task, or create a new schedule.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

5 When you finish viewing or editing the task, you can close the task page.

Configure HP BIOS Settings pages
These pages let you create a task to modify the BIOS settings for one or more HP
client computers. The pages appear when you run the HP BIOS Administration
Wizard.

See “Modifying the BIOS settings of HP client computers” on page 110.

The pages in the HP BIOS Administration Wizard are as follows:

Lets you select specific BIOS settings to configure.

See Table 8-1.

Choose BIOS settings

Lets you select the computers on which to modify BIOS settings.

See Table 8-2.

Choose computers

Lets you define the schedule for applying these modifications to
the computers.

See Table 8-3.

Choose when to run

Table 8-1 Tabs and options on the Choose BIOS settings page

DescriptionOptionTab

Lets you change the BIOS password.

The options are as follows:

■ Leave Existing
■ Leave password blank (not recommended)
■ Set password

BIOS passwordMain tab

If you choose to set a new password, you must type the new
password and then re-type the password to confirm it.

Case-sensitive characters and special characters are supported.

New password

Confirmnewpassword

Main tab

For each setting that appears, you can click Leave Existing or
you can select another option to change the setting.

Scroll down the tab to see all the settings.

SettingsMain tab

Managing the BIO settings of HP client computers
Configure HP BIOS Settings pages

112



Table 8-1 Tabs and options on the Choose BIOS settings page (continued)

DescriptionOptionTab

Lets you assign a number to an HP client computer so that you
can track it in HP Client Manager. The tracking number is limited
to 16 characters.

Asset Tracking
Number

Advanced tab

The settings that
appear on this tab are
gathered during the
client computer
inventory process.

Lets you specify a time at which one or more HP client computers
are turned on.

BIOS Power On

Time

Advanced tab

For each setting that appears, you can click Leave Existing or
you can select another option to change the setting.

Scroll down the tab to see all the settings.

SettingsAdvanced tab

Lets you set the device boot order for the client computers any
time they are reset or turned on.

You can leave the boot order as it is or click Change boot order
and use the up and down arrow symbols to rearrange the boot
order.

Leave existing

Change boot order

Boot order tab

Lets you enter the Current BIOS Setup Password so that the
BIOS changes are accepted at the client computers. If the
password that you enter does not match the password of the HP
client computer, the BIOS changes are not accepted.

Current BIOS Setup
Password

Not applicable

When you set a new password, this option allows the entry of
numeric characters in the BIOS password from the numeric
keypad on the keyboard.

Allow NumpadNot applicable

Table 8-2 Options on the Choose computers page

DescriptionOption

Lets you select a single target.

When you select this option, the Quick apply dialog box appears. You can select a target
from the drop-down list, and you can type the first few characters of the target name to
filter the list.

Apply to>Quickapply
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Table 8-2 Options on the Choose computers page (continued)

DescriptionOption

Lets you select one or more filters, computers, or resources.

When you select one of these options, the Select computers dialog box or the Select
resources dialog box appears.

You can select the target in one of the following ways:

■ You can click Open to select an existing filter.

■ Under Filtering Rules, you can add one or more rules to specify the parameters for
filtering the computers or resources, and then click Update results.

Apply to > Computers
or Apply to >
Resources

Table 8-3 Options on the Choose when to run page

DescriptionOption

Lets you run the task as soon as possible, unless it must wait for a maintenance window.

A maintenance window is a scheduled time and duration when maintenance operations
may be performed on a managed computer.

Now

Lets you schedule the task to run at a specific time.

When you select this option, the following options are available:

■ At date/time
Lets you specify the date and time at which the task runs. You can also indicate whether
the task is repeated and set the frequency.

■ Shared schedule
Lets you select from a list of predefined schedules that are available for any scheduled
operation to use. For example, the daily schedule is set for 2:10 A.M. every day. You
can also define additional shared schedules.

For more information, see the topics about managing shared schedules in the Symantec
Management Platform Help.

Schedule

Creating HP BIOS reports
HP Client Manager provides a single, predefined report that lists the BIOS
information for all your managed HP computers. Because the large number of
BIOS settings makes it impractical to predefine reports for every possible
combination, HP Client Manager lets you create custom reports. You can create
custom reports to filter the information that is reported.

The HP BIOS Report Wizard guides you through the creation of a custom BIOS
report. It lets you select any number of BIOS settings, which become the selectable
parameters in the report that is created.
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The reports that the wizard creates are given generic names. After a report is
created, you can edit its name and description on the report page.

The HP BIOS reports use the inventory data that the HP Client Inventory task
collects and stores in the CMDB (Configuration Management Database).

See “About HP BIOS Settings” on page 109.

To create BIOS reports

1 In the SymantecManagementConsole, on the Reports menu, click HPClient
Manager > Create HP BIOS Reports.

2 In the HP BIOS Report Wizard, on the Instructions page, click Next.

3 On the Settings page, select one or more HP BIOS settings to include, and
then click Next.

4 On the Configuration page, specify whether to join the BIOS settings with
the OR operator or the AND operator, and then click Finish.

5 On the report page that appears, take one of the following actions:

■ Close the page.

■ Run the report.
See “Viewing the HP BIOS reports” on page 116.

■ Edit the report.
You can change the report name and description.
See “Editing an HP BIOS report” on page 115.

Editing an HP BIOS report
The HP BIOS Report Wizard guides you through the creation of custom BIOS
reports. The reports that the wizard creates are given generic names. To more
easily manage your BIOS reports, you might want to change the report names and
descriptions.

Warning: We do not recommend changing any other report information. Change
it only if you are familiar with customizing reports in the Symantec Management
Platform.

For more information, see the topics about creating customized reports in the
Symantec Management Platform Help.
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To edit an HP BIOS report

1 On the HPClientManagerHome page, under ManagementTasks, click BIOS
Management > View HP Computer BIOS Information Reports.

See “Accessing the HP Client Manager Home page” on page 62.

2 In the left pane, click Reports > HP Client Manager > HP BIOS, and then
select a report.

3 In the right pane, on the report page, click Edit.

If the Edit option is not available, the report cannot be edited.

4 To change the report name, click the existing report name and type the new
name.

Repeat this step for the description, which is the line of text that appears
under the report name.

5 Click Cancel to close the edit mode.

You do not need to save the changes because the name and description are
changed as soon as you type them

6 You can close the page or run the report.

See “Viewing the HP BIOS reports” on page 116.

Viewing the HP BIOS reports
HP Client Manager gathers information about the BIOS settings of your managed
HP computers. You can also modify the BIOS settings on the client computers.
You can use the HP BIOS reports to view and analyze the BIOS data.

The HP Computer BIOS Information report lists detailed BIOS information for all
the HP client computers. To filter the BIOS information in different ways, you
can create custom reports and run them as you would any other report.

See “Creating HP BIOS reports” on page 114.

For more information, see the topics about viewing and managing resource data
with reports in the Symantec Management Platform Help.

To view the HP BIOS reports

1 On the HPClientManagerHome page, under ManagementTasks, click BIOS
Management > View HP Computer BIOS Information Reports.

See “Accessing the HP Client Manager Home page” on page 62.

2 In the left pane, under Reports > HP Client Manager > HP BIOS, select a
report.
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3 When the report appears in the right pane, click Refresh to display the latest
information.

4 Under Parameters, you can select additional ways to organize and display
the information. After you select new parameters, click Refresh.

5 (Optional) You can print the report or save it in a variety of formats. Other
actions might be available depending on the type of report.
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Monitoring HP client
computer health

This chapter includes the following topics:

■ About health monitoring and alerts

■ Monitoring the health of HP client computers

■ Initiating the HP client health monitoring

■ HP Health Monitoring Task page

■ Configuring local alerts for HP client computers

■ HP Local Alerts Configuration Task page

■ About health alert automation

■ Enabling an HP Client Manager automation policy

■ Options for automation policies in HP Client Manager

■ About the email settings for HP Client Manager automation policies

■ Customizing an HP Client Manager automation policy

■ Customizing an HP Client Manager automation task

■ Customizing an HP Client Manager automation job

■ Viewing the HP health monitor reports
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About health monitoring and alerts
HP Client Manager monitors the health of your managed HP computers so that
issues can be addressed before performance is affected. The computer health is
defined as a set of elements that perform within a range of values and functionality.
When a health-related element is outside a set range or does not function in the
desired state, a health alert is created. The alert is sent to the Notification Server
computer and is stored in the CMDB (Configuration Management Database).

You can monitor and receive alerts on the following elements:

■ Asset changes
Monitors any changes to the assets of the client computer.

■ Threshold levels
Monitors the levels of disk space and battery charge.

■ Hardware health
Monitors the hardware on the client computer.

You can configure which elements are monitored. The availability of the alerts
varies by platform.

On the Notification Server computer, predefined automation policies can monitor
the CMDB for computer health events and perform notification actions based on
the events. For example, if an asset change event is sent to the CMDB, an
automation policy can run the Asset Change Alert report. It can also email the
URL of that report to a designated administrator.

You can enable and edit the predefined notification policies. If you do not want
certain alert actions to occur, you can leave the corresponding automation policies
disabled.

You can also configure the alerts to appear on the HP client computers. You can
specify the alerts to display and the options for displaying them.

See “Monitoring the health of HP client computers” on page 120.

Monitoring the health of HP client computers
HP Client Manager can monitor the health of your managed HP computers, create
alerts when issues are found, and notify you of the alerts.

See “About health monitoring and alerts” on page 120.
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Table 9-1 Process for monitoring the health of HP client computers

DescriptionActionStep

The HP Health Monitoring task lets you specify the categories of hardware
health issues to monitor, the client computers to monitor, and the
monitoring schedule.

See “Initiating the HP client health monitoring” on page 121.

Initiate the HP client
health monitoring.

Step 1

The HP Local Alerts Configuration task lets you configure the alerts to
display and the options for displaying the alerts on specific client
computers.

See “Configuring local alerts for HP client computers” on page 123.

Configure local alerts
for HP client
computers.

Step 2

Determines the actions that are taken when specific health alerts occur.

The HP Client Manager automation policies can perform any of the
following alert actions:

■ Generate a snapshot report.

■ Send an email.

■ Send an email that contains the URL of the generated report.

This action is the default for all the HP Client Manager automation
policies.

See “Enabling an HP Client Manager automation policy” on page 127.

Configure the
automation policies to
perform the alert
actions.

Step 3

Lets you view the alert data. These reports help you identify and analyze
issues with your managed HP computers.

See “Viewing the HP health monitor reports” on page 133.

View the HP health
monitor reports.

Step 4

Initiating the HP client health monitoring
HP Client Manager collects computer health information from your managed HP
client computers. It creates an alert for any health-related element that is outside
a set range or that does not function in the desired state.

The HP Health Monitoring task monitors the computers that you specify according
to the schedule that you set. You can select the categories of hardware health
issues to monitor. By default, the HP Health Monitoring task is set to monitor all
types of health elements.

This task is a step in the process for monitoring the health of HP client computers.

See “Monitoring the health of HP client computers” on page 120.

After you configure the HP Health Monitoring task, you can configure more
specific alert settings for the client computers.
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See “Configuring local alerts for HP client computers” on page 123.

To initiate the HP client health monitoring

1 On the HP Client Manager Home page, under Management Tasks, click
Alerts > HP Health Monitoring.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the HP Health Monitoring Task page, under Software Settings, select
the alerts to enable. You can also specify the threshold levels for the disk
space and battery charge.

See “HP Health Monitoring Task page” on page 122.

3 If you changed any of the settings, click Save Changes.

4 Under TaskStatus, you can run the task immediately or create a new schedule.

To roll out the task to all managed HP computers, create a new schedule and
add a target that uses the following filtering rule:

exclude computers not in

Filter

Computers with HP Client Manager Agent Installed

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

5 When you finish scheduling the task, you can close the task page.

HP Health Monitoring Task page
This page lets you specify the categories of HP hardware health issues to monitor
and send alerts for. This page appears when you configure the HP Health
Monitoring task. By default, all the alert categories are selected. You can change
the defaults.

See “Initiating the HP client health monitoring” on page 121.
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Table 9-2 Options on the HP Health Monitoring Task page

DescriptionOption

Monitors any changes that are made to the following areas of
the target computers:

■ Battery

■ Disk drive

■ CPU

■ Memory

■ Monitor

■ Chassis lock status

Asset change alerts

Monitors the levels of disk space and battery charge and notifies
you when the levels are less than an acceptable level.

By default, you are alerted if the free disk space is less than 30
percent or the remaining battery charge is less than 5 percent.
You can change these threshold levels.

Threshold alerts

Monitors the following hardware problems:

■ S.M.A.R.T disk drive predictive failures

■ CPU thermal

■ Fan stall

■ Chassis intrusion sensor

■ Memory warnings

■ Cable not detected for audio, fan, or USB

■ Battery charge degradation

Hardwarehealthalerts

Lets you schedule the task and select the target computers.

See “Scheduling and selecting target computers in an HP Client
Manager task” on page 65.

Task Status section

Configuring local alerts for HP client computers
The HP Local Alerts Configuration task lets you configure the specific hardware
health issues to monitor on one or more managed HP computers. The ability to
enable and disable individual alerts provides more granularity and control over
the health alerts. For example, you can disable the threshold monitoring of disk
space on certain computers.

The local settings are more specific than the categories that you configure with
the HP Health Monitoring task.

See “Initiating the HP client health monitoring” on page 121.
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By default, this task is set to use the existing settings that were applied to each
overall category. The local settings cannot enable any health issue monitoring
that the HP Health Monitoring task disables. For example, if the entire asset
changes category is disabled, the specific asset changes are never monitored
regardless of the local settings.

The HP Local Alerts Configuration task also lets you configure settings for
displaying the alerts on the client computers.

This task is a step in the process for monitoring the health of HP client computers.

See “Monitoring the health of HP client computers” on page 120.

After you configure the local alert settings, you can configure the automation
policies that perform alert actions.

See “Options for automation policies in HP Client Manager” on page 128.

To configure local alerts for HP client computers

1 On the HP Client Manager Home page, under Management Tasks, click
Alerts > HP Local Alerts.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the HPLocalAlertsConfigurationTask page, under LocalAlertsettings,
configure the options to determine how the alerts are displayed on the client
computers.

See “HP Local Alerts Configuration Task page” on page 125.

3 Under Whatalertwouldyou like toconfigure?, click a tab and configure the
specific settings for each health issue.

You can leave the existing setting that was applied to the overall category,
or you can enable or disable the setting.

Repeat this step for each tab.

4 If you changed any of the settings, click Save Changes.
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5 Under TaskStatus, you can run the task immediately or create a new schedule.

To roll out the task to all managed HP computers, create a new schedule and
add a target that uses the following filtering rule:

exclude computers not in

Filter

Computers with HP Client Manager Agent Installed

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

6 When you finish scheduling the task, you can close the task page.

HP Local Alerts Configuration Task page
This page lets you configure the specific hardware health issues to monitor on
one or more managed HP computers. This page appears when you configure the
HP Local Alerts Configuration task.

See “Configuring local alerts for HP client computers” on page 123.

Table 9-3 Options on the HP Local Alerts Configuration Task page

DescriptionOption

Determines whether users can enable or disable alerts on the client computers.

When you select this option, the Alert icon appears in the system tray on the client
computers. Users can right-click the icon to disable local notification of events. They
can also right-click or double-click the icon to view a log of events.

Enable Local Alerts on
clients(Displayanalerticon
in the user’s system tray)

Lets the user close the alert dialog box.Allow users to close local
alerts

Specifies the number of seconds that the alert appears on the client computer before
it closes. The default is 20 seconds.

Automaticallyremovealert
after x seconds
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Table 9-3 Options on theHPLocal Alerts Configuration Taskpage (continued)

DescriptionOption

Determines which specific hardware health issues are monitored.

The alerts are categorized under the following tabs: Asset change, Threshold, and
Hardware health.

The options for configuring individual health issues are as follows:

■ Leave existing
Uses the same setting that was applied to the overall category. For example, if
the HP Health Monitoring task enabled the entire category, then this option leaves
the specific setting enabled.

■ Enable
The local settings cannot enable any health issue monitoring that the HP Health
Monitoring task disabled. For example, if the entire asset changes category is
disabled, the specific asset changes are never monitored regardless of the local
settings.

■ Disable
The local settings can disable any health issue monitoring that the HP Health
Monitoring task enabled. For example, if the entire asset changes category is
enabled, you can disable the monitoring of a specific asset change.

Whatalertwouldyouliketo
configure?

Lets you schedule the task and select the target computers.

See “Scheduling and selecting target computers in an HP Client Manager task”
on page 65.

Task Status section

About health alert automation
HP Client Manager can monitor the health of your managed HP computers, create
alerts when issues are found, and notify you of the alerts. You can use automation
policies to automate the process of running HP health monitor reports and sending
notifications.

See “About health monitoring and alerts” on page 120.

An automation policy specifies the automated actions to perform on client
computers or the Notification Server computer. These policies are dynamic. They
target the appropriate computers when the policy is activated and perform
whatever action is required based on the current state of each target computer.
Automation policy targets may be based on report results or a query, rather than
filters and resource targets as for other policy types.

For more information, see the topics about automation policies in the Symantec
Management Platform Help.
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HP Client Manager contains the predefined automation policies, jobs, and tasks
that perform the most common health alert actions.

Table 9-4 How the predefined automation policies, jobs, and tasks work
together

How it worksItem

Monitors the CMDB for health events on client computers and performs an action when
it detects an event.

The action depends on the job or task that the policy contains. Each predefined automation
policy contains an automation job and the criteria that determine when to run the job.

You can customize an automation policy to run a different job or task.

See “Customizing an HP Client Manager automation policy” on page 130.

Automation policy

Runs a series of tasks to perform the action that an automation policy takes when the
policy trigger occurs.

Each predefined automation job contains predefined automation tasks. By default, one
task runs an HP health monitor report and another task sends an email with a link to the
report results.

You can customize an automation job to add and delete automation tasks.

See “Customizing an HP Client Manager automation job” on page 132.

Automation job

Performs a single action.

One of the predefined automation tasks sends an email with a link to the report results.
The remaining tasks run specific HP health monitor reports.

You can customize an automation task to send the email to a different address or to run
a different report.

See “Customizing an HP Client Manager automation task” on page 131.

Automation task

If you plan to use the HP Client Manager automation policies to perform health
alert actions, you must enable the policies.

See “Enabling an HP Client Manager automation policy” on page 127.

Enabling an HP Client Manager automation policy
HP Client Manager contains predefined automation policies, which can perform
alert actions when health events are detected on HP client computers. You can
select the automation policies to use and you can configure the actions that they
take.

See “About health alert automation” on page 126.
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By default, the HP Client Manager automation policies are turned off. You must
turn on (enable) the automation policies that you plan to use.

This task is a step in the process for monitoring the health of HP client computers.

See “Monitoring the health of HP client computers” on page 120.

The automation policies send the alert notifications to the email address that is
configured in Notification Server. You can customize the policies to send the
notifications to different email addresses.

See “Customizing an HP Client Manager automation policy” on page 130.

Before you enable a policy, you can test it to ensure that it works. When you test
the policy, a test report is generated and an email is sent with a link to the report
results. The report name is HPCMS Report Test. You can click the link in the email
to view the report.

To enable an HP Client Manager automation policy

1 In the Symantec Management Console, on the Manage menu, click
Automation Policies.

2 On the AutomationPolicies page, on the Schedules tab, select one of the HP
Client Manager policies from the list.

3 In the right pane, on the policy page, you can accept the default schedule or
you can change it.

The schedule determines when the automation policy runs.

For example, you can specify a 1-minute schedule for testing purposes.

4 (Optional) Configure any other settings as needed.

See “Options for automation policies in HP Client Manager” on page 128.

5 If you made any changes, click Save Changes.

6 To test this policy, click Test Automation Policy.

7 On the policy page, turn on the policy.

At the upper left of the Schedules tab, the second option from the left toggles
from Turn on to Turn off.

8 After you turn on the policy, you can close the policy page.

Options for automation policies in HPClientManager
When you open one of the HP Client Manager automation policies, its policy page
appears in the right pane. This page lets you configure and enable the selected
automation policy.
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If you plan to use the HP Client Manager automation policies to perform health
alert actions, you must enable the policies.

See “Enabling an HP Client Manager automation policy” on page 127.

You can customize the predefined automation policies. For example, you can
change the recipients of an alert notification email.

See “Customizing an HP Client Manager automation policy” on page 130.

For more information, see the topics about automation policies and alerts in the
Symantec Management Platform Help.

Table 9-5 Options for automation policies in HP Client Manager

DescriptionOption

The schedule triggers the automation policy to evaluate the data.

For example, at the scheduled time the HP Client Manager automation policies check the
CMDB for the existence of health alerts.

You can accept the default schedule or you can change it.

Schedule

Select sharedschedule

Contains the source of the data from which the automation policy sends information.

For the health scan alerts, a SQL query is provided to generate the result set. This query’s
results can be added as an output in the email message that an alert generates.

Data source

Evaluates the data in the data source and determines whether an action should be
performed.

By default, the policy runs on non-empty data, which means that it performs the action
only when the query returns data.

Evaluation Rule

Performs the action that the automation policy takes when the data source returns a result.

You can click the job name to view its configuration or to select a different job for the
policy.

See “Customizing an HP Client Manager automation policy” on page 130.

Run job/task

None of the predefined tasks for HP Client Manager accept parameters.Edit input parameter

Lets you test the policy to ensure that it works. When you test the policy, a test report is
generated and an email is sent with a link to the report results. The report name is HPCMS
Report Test. You can click the link in the email to view the report.

If the email is not received, check the email settings.

TestAutomationPolicy

See “About health alert automation” on page 126.
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About the email settings for HP Client Manager
automation policies

On the Notification Server computer, predefined automation policies can monitor
the CMDB for computer health events and perform notification actions based on
the events.

HP Client Manager contains predefined automation policies, which help to
automate the process of running HP health monitor reports and sending alert
notifications. By default, the automation policies send the alert notifications to
the email address that is configured in Notification Server.

See “Configuring the email settings in Notification Server” on page 59.

You can send the notifications to different email addresses. Because the Send
Automation Policy E-Mail automation task sends the email, you must change
the email settings in that task. Then you can edit the jobs and policies that use
the email task.

See “Customizing an HP Client Manager automation policy” on page 130.

You can change the recipients and subject of the message, and you can change
the advanced settings for sending the email. For example, you can change the To
address and add CC addresses.

Note: If you specify the CC address and leave the To address blank, the task fails.

If you leave both the To and CC addresses blank, the email is sent to the default
email address that is defined in Notification Server.

Customizing anHPClientManager automation policy
HP Client Manager contains predefined automation policies, which can perform
alert actions when health events are detected on HP client computers.

See “About health alert automation” on page 126.

Examples of why you might customize an automation policy are as follows:

■ To change the recipients of an alert notification email.
See “About the email settings for HP Client Manager automation policies”
on page 130.

■ To save a generated report as a filter instead of a snapshot.
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Table 9-6 Process for customizing an HP Client Manager automation policy

DescriptionActionStep

You can customize the task configurations, but you cannot change the
task’s action.

For example, to send alert notifications to a different email address, you
can customize the Send Automation Policy E-Mail task. However, you
cannot change a report task to an email task.

See “Customizing an HP Client Manager automation task” on page 131.

Customize the
automation task.

Step 1

You can customize an automation job to add and delete automation tasks.
For example, you can delete the default email task and replace it with a
task that sends an email to a different address.

See “Customizing an HP Client Manager automation job” on page 132.

Customize the job that
includes that task.

Step 2

You can customize an automation policy to run a different automation job
or task. For example, you can customize a policy to send its notifications
to different email addresses.

You can create a customized automation policy in one of the following
ways:

■ Edit the existing policy to use the customized job or task.

■ Clone the existing policy and edit the clone as needed.

See “Enabling an HP Client Manager automation policy” on page 127.

Configure the
automation policy to
use the customized job.

Step 3

Customizing an HP Client Manager automation task
HP Client Manager contains predefined automation tasks, which help to automate
the process of running HP health monitor reports and sending alert notifications.
One of the predefined automation tasks sends an email with a link to the report
results. The remaining tasks run specific HP health monitor reports.

You can customize these automation tasks to send the email to a different address
or to run a different report. However, you cannot change a task’s action. For
example, you cannot change a report task to an email task.

This task is a step in the process for customizing an HP Client Manager automation
policy.

See “Customizing an HP Client Manager automation policy” on page 130.
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To customize an HP Client Manager automation task

1 In the SymantecManagementConsole, on the Manage menu, click Jobsand
Tasks.

2 In the left pane, click Jobs and Tasks > System Jobs and Tasks > HP Client
Manager > Automation Policy Jobs and Tasks.

3 Under Automation Policy Jobs and Tasks, right-click the task, and then on
the context menu, click Clone.

4 In the Clone Item dialog box, type the name for the new task, and then click
OK.

5 When the clone appears in the list of jobs and tasks, select it.

6 In the right pane, on the task page, make the changes.

For example, in the HP Client Manager automation tasks, you can make the
following changes:

■ In the SendAutomationPolicyE-Mail task, you can change the recipients
and subject of the message, and you can change the advanced settings for
sending the email.
See “About the email settings for HP Client Manager automation policies”
on page 130.

■ In the tasks that run reports, you can select a different report to run and
a different format in which to save the report results.

7 When you finish editing the task, click Save changes.

Customizing an HP Client Manager automation job
An automation job runs a series of tasks to perform the action that an automation
policy takes. HP Client Manager contains predefined automation jobs, which help
to automate the process of running HP health monitor reports and sending alert
notifications.

Each predefined automation job contains predefined automation tasks. By default,
one task runs an HP health monitor report and another task sends an email with
a link to the report results.

You can customize an automation job to add and delete automation tasks. For
example, you can delete the email task and replace it with a task that sends an
email to a different address. You can use the customized job in any of the
automation policies.

This task is a step in the process for customizing an HP Client Manager automation
policy.
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See “Customizing an HP Client Manager automation policy” on page 130.

To customize an HP Client Manager automation job

1 In the SymantecManagementConsole, on the Manage menu, click Jobsand
Tasks.

2 In the left pane, click Jobs and Tasks > System Jobs and Tasks > HP Client
Manager > Automation Policy Jobs and Tasks.

3 Under Automation Policy Jobs and Tasks, right-click the job, and then on
the context menu, click Clone.

4 In the Clone Item dialog box, type the name for the new job, and then click
OK.

5 When the clone appears in the list of jobs and tasks, select it.

6 In the right pane, on the job page, under Jobs/Tasks, select the task to replace,
and then click the Delete symbol (a red X).

7 Click Add Existing.

8 In the Add Existing Task dialog box, in the left pane, navigate to the task to
add, select it, and then click OK.

9 On the job page, under Jobs / Tasks, use the Up Arrow and Down Arrow
symbols to arrange the tasks in the correct execution order.

10 (Optional) Make additional changes as needed.

For more information, see the topics about using tasks and creating a job in
the Symantec Management Platform Help.

11 When you finish editing the job, click Save changes.

Viewing the HP health monitor reports
HP Client Manager monitors the health of your managed HP computers. When a
health-related element is outside the set range or does not function in the desired
state, a health alert is created. You can use the HP health monitor reports to view
the alert data. These reports help you identify and analyze issues with the HP
client computers in your organization.

Examples of how you can use the health monitoring data are as follows:

■ Find any computers whose batteries have dropped below a default charge
threshold.

■ Track component failure trends and find any computers on which the specified
failure rate is exceeded.
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■ Find all the asset changes that have occurred within the last month.

See “About health monitoring and alerts” on page 120.

For more information, see the topics about viewing and managing resource data
with reports in the Symantec Management Platform Help.

To view the HP health monitor reports

1 On the HP Client Manager Home page, under Management Tasks, click
Alerts > View HP Health Monitor Reports.

See “Accessing the HP Client Manager Home page” on page 62.

2 In the left pane, click Reports > HP Client Manager > HP Health Monitor,
and then select a report.

3 When the report appears in the right pane, click Refresh to display the latest
information.

4 If the report page contains a Parameters section, you can select additional
ways to organize and display the information. After you select new
parameters, click Refresh.

5 (Optional) You can print the report or save it in a variety of formats. Other
actions might be available depending on the type of report.
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Performing HP Instant
Support diagnostics

This chapter includes the following topics:

■ About HP Instant Support diagnostics

■ Performing the HP Instant Support diagnostics

■ Installing the HP Instant Support Diagnostics tool

■ Viewing the computers that have the HP Instant Support tools

■ Running HP Instant Support diagnostics on client computers

■ Viewing the HP Instant Support diagnostic reports

About HP Instant Support diagnostics
HP Client Manager is integrated with the HP Instant Support Diagnostics tool,
which automates the troubleshooting of hardware and configuration issues on
HP client computers. The tool performs diagnostic checks on the client computers
and collects the resulting data. The HP Client Manager Agent on each computer
sends that computer’s data to the Notification Server computer. The HP Instant
Support Diagnostics reports let you view the results of the diagnostic checks.

The HP Instant Support Diagnostics tool is stored on the Notification Server
computer so that it can be installed on HP client computers. You can update this
tool when HP makes updates available.

See “About the HP tools in HP Client Manager” on page 143.

The HP Instant Support Diagnostics tool contains a set of modules that collect
diagnostic data for the following hardware on HP computers:
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■ IDE hard disk

■ LAN

■ Memory

■ Parallel and serial ports

■ Processor

The process for performing the HP Instant Support diagnostics requires little
administrator interaction, other than to review the results.

See “Performing the HP Instant Support diagnostics” on page 136.

Performing the HP Instant Support diagnostics
The HP Instant Support Diagnostics tool automates the troubleshooting of
hardware and configuration issues on HP client computers. Because predefined
tasks perform the diagnostics, little administrator interaction is required.

See “About HP Instant Support diagnostics” on page 135.

Table 10-1 Actions for performing the HP Instant Support diagnostics

DescriptionFrequencyAction

The Install HP Instant Support Diagnostics task installs the tools
on the HP client computers that have the HP Client Manager Agent.

By default, this task runs once a week. You can skip this step unless
you need to run it on a different schedule or on a different group
of computers.

See “Installing the HP Instant Support Diagnostics tool” on page 137.

Once a week,
automatically

Install the HP Instant
Support Diagnostics
tool on managed HP
client computers.

As you add new HP client computers to your network, you can
verify that the HP Instant Support diagnostic tools are installed
on them.

As the diagnostic tools are installed on a computer, that computer
is added to a filter. You can view the computers in that filter.

See “Viewing the computers that have the HP Instant Support
tools” on page 138.

As neededVerify that the HP
Instant Support tools
are installed.
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Table 10-1 Actions for performing the HP Instant Support diagnostics
(continued)

DescriptionFrequencyAction

The Perform HP Instant Support Diagnostics task gathers
diagnostic data from HP client computers.

By default, this task runs at 2:00 A.M. on the last Sunday of every
month. You can skip this step unless you want to create additional
schedules.

See “Running HP Instant Support diagnostics on client computers”
on page 138.

Once a month,
automatically

Run the diagnostics.

As the diagnostic data is gathered and updated, you can use the
HP Instant Support Diagnostics reports to view the data. These
reports help you analyze and identify issues with your managed
HP client computers.

See “Viewing the HP Instant Support diagnostic reports”
on page 139.

As neededView the diagnostic
data.

Installing the HP Instant Support Diagnostics tool
For HP Instant Support diagnostics to be run on HP client computers, those
computers must have the HP Instant Support Diagnostics tool installed. The
Install HP Instant Support Diagnostics task automatically installs the tool on all
the managed HP client computers that have the HP Client Manager Agent.

By default, this task runs once a week. You can skip this step unless you need to
run it on a different schedule or on a different group of computers.

See “About HP Instant Support diagnostics” on page 135.

As you add new HP computers to your network, you can verify that the HP Instant
Support tools are installed on them.

See “Viewing the computers that have the HP Instant Support tools” on page 138.
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To view or modify the HP Instant Support Diagnostics Install task

1 On the HP Client Manager Home page, under Management Tasks, click HP
Instant Support > Install HP Instant Support Diagnostics.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the task page, under Task Status, you can view the details of an existing
task instance, run the task, or create a new schedule.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

3 When you finish viewing or scheduling the task, you can close the task page.

Viewing the computers that have the HP Instant
Support tools

The HP Instant Support Diagnostic tool is installed automatically on HP client
computers to collect diagnostic data.

See “About HP Instant Support diagnostics” on page 135.

As you add new HP computers to your network, you can verify that the HP Instant
Support Diagnostics tool is installed on them.

As the tool is installed on a computer, that computer is added to a filter. A filter
(resource filter) is a dynamic definition of a set of resources that have specified
parameters in common. HP Client Manager contains several predefined filters,
including one that contains the HP computers that have the diagnostic tool.

To view the computers that have the HP Instant Support Diagnostic tool

1 In the Symantec Management Console, on the Manage menu, click Filters.

2 In the left pane, click Filters>HPClientManagerFilters>AllHPComputers
with HP Instant Support Diagnostics tools installed.

3 In the right pane, under Filter Membership, click Update membership.

Running HP Instant Support diagnostics on client
computers

HP Client Manager is integrated with the HP Instant Support Diagnostics tool,
which automates the troubleshooting of hardware and configuration issues on
HP client computers. The Perform HP Instant Support Diagnostics task runs the
tool on the client computers and gathers the data such as processor speed and
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memory configuration. The HP Client Manager Agent on each computer sends
that computer’s data to the Notification Server computer.

See “About HP Instant Support diagnostics” on page 135.

We recommend that you collect data during off-peak network hours and on a
monthly basis to minimize the effect on the network.

By default, this task runs at 2:00 A.M. on the last Sunday of every month. It runs
on the computers that belong to the following filter: All HP Computers with HP
Instant Support Diagnostics Installed. You can skip this step unless you want to
run it on a different schedule or on a different group of computers.

Before the HP Instant Support Diagnostics task can be run, the HP Instant Support
tools must be installed on HP client computers.

See “Installing the HP Instant Support Diagnostics tool” on page 137.

You can view the results of the diagnostic data collection in any of the HP Instant
Support diagnostic reports.

See “Viewing the HP Instant Support diagnostic reports” on page 139.

To view or modify the HP Instant Support Diagnostics task

1 On the HP Client Manager Home page, under Management Tasks, click HP
Instant Support > Perform HP Instant Support Diagnostics.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the task page, under Task Status, you can view the details of an existing
task instance, run the task, or create a new schedule.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

3 When you finish viewing or scheduling the task, you can close the task page.

Viewing the HP Instant Support diagnostic reports
HP Client Manager lets you gather HP Instant Support diagnostic information
from managed HP client computers. As the diagnostic data is gathered and updated,
you can use the HP Instant Support Diagnostics reports to view the data. These
reports help you identify and analyze issues with the HP client computers in your
organization.

See “About HP Instant Support diagnostics” on page 135.

See “Running HP Instant Support diagnostics on client computers” on page 138.

For more information, see the topics about viewing and managing resource data
with reports in the Symantec Management Platform Help.
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To view the HP Instant Support diagnostic reports

1 On the HP Client Manager Home page, under Management Tasks, click HP
Instant Support > View HP Instant Support Diagnostics Reports.

See “Accessing the HP Client Manager Home page” on page 62.

2 In the left pane, under HP Instant Support Diagnostics, select a report.

3 When the report appears in the right pane, click Refresh to display the latest
information.

4 If the report page contains a Parameters section, you can select additional
ways to organize and display the information. After you select new
parameters, click Refresh.

5 (Optional) You can print the report or save it in a variety of formats. Other
actions might be available depending on the type of report.
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Performing administrative
tasks

This chapter includes the following topics:

■ About the HP Supported Systems list

■ Updating the HP Supported Systems list

■ About the HP tools in HP Client Manager

■ About updating HP tools automatically

■ Updating HP tools with the Update HP Tools wizard

■ About HP backup and recovery

■ Requirements for HP backup and recovery

■ Performing an HP backup

■ Performing a disaster recovery

■ Purging HP data

■ Uninstalling the HP Client Manager Agent

About the HP Supported Systems list
The HP Supported Systems list contains all the computer models that HP Client
Manager supports. When HP releases a new computer model, it is tested and
validated with HP Client Manager, and then it is added to the list. HP Client
Manager uses this list to determine whether a discovered computer is an HP client
computer that requires the HP Client Manager Plug-in.
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The HP Supported Systems list contains the following information about each
supported computer:

■ System ID (SysId)

■ Computer name

■ System classification
For example, Desktop, Notebook, or Workstation.

■ An indication of whether a TPM license is required

The master list is in XML format and resides on a Web page. The information in
the list is also stored locally in the CMDB (Configuration Management Database)
on the Notification Server computer. You must update the local list periodically
to ensure that it contains the most recent computers. Typically, you update the
list whenever you add a new HP computer model to your environment.

HP Client Manager contains a predefined task that updates the HP Supported
Systems list.

See “Updating the HP Supported Systems list” on page 142.

Updating the HP Supported Systems list
The HP Supported Systems list contains all the computer models that HP Client
Manager supports. HP Client Manager uses the information in this list to identify
HP client computers. Whenever you add a new HP computer model to your
environment, you should update the list that is in your CMDB (Configuration
Management Database).

See “About the HP Supported Systems list” on page 141.

The master list is in XML format and resides on a Web page. The Update HP
Supported Systems task downloads the latest list from the master list and updates
the CMDB with the new information.

If your Notification Server computer does not have Internet access, you can
download the list on another computer and save it in an accessible location. From
the Notification Server computer, you can update the CMDB from the file that
you downloaded.
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To update the HP supported systems list

1 On the Notification Server computer, on the HPClientManagerHome page,
under Administrative Tasks, click Update HP Supported Systems List.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the Update HP Supported Systems page, a message indicates the status
of your current list. Take one of the following actions:

■ If your list is up to date, no further action is needed and you can close this
page.

■ If your list is not up to date, continue this procedure to update the list.

3 Select the supported systems list to download in one of the following ways:

Click Internet.If the computer is
connected to the
Internet

■ On a different computer, download the XML file from
the URL that appears on this page. Save the file in a
location that the Notification Server computer can
access.

■ On the Update HP Supported Systems page, click File,
and then specify the file that you downloaded.

If the computer is not
connected to the
Internet

4 Click Update.

5 After the list is updated, you can close the page.

About the HP tools in HP Client Manager
HP Client Manager uses several tools from HP to help you manage your HP client
computers.
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Table 11-1 HP tools in HP Client Manager

DescriptionTool

Analyzes an HP client computer to check its overall health status.
The scan can identify problems, check to see if the latest drivers
are installed, and provide recommendations for resolving
potential issues.

See “About HP Instant Support System Health Scan” on page 96.

The System Health Scan tool is incorporated into the HP Client
Manager Agent.

HP Instant Support
System Health Scan

Automates the troubleshooting of hardware and configuration
issues on HP client computers.

See “About HP Instant Support diagnostics” on page 135.

The Diagnostics tool must be installed separately on the HP client
computers.

HP Instant Support
Diagnostics

Helps streamline the mass deployment of system software
updates to HP client computers by automatically detecting and
updating BIOS, device driver, and management agent versions.

The SSM tool is incorporated into the HP Client Manager Agent.

HP System Software
Manager (SSM)

The HP tools are stored on the Notification Server computer. From there, HP
Client Manager can use the tools and deploy them to the HP client computers.

Periodically, HP updates these tools.

You can update the versions of the HP tools that are in your environment in the
following ways:

By default, this Windows task runs at 2:30 A.M. daily, but you
can edit the task to change the schedule.

See “About updating HP tools automatically” on page 145.

Automatically by the
NS.HP Tool Update
scheduled task.

You can run this wizard to perform an update between the times
when the scheduled task runs.

See “Updating HP tools with the Update HP Tools wizard”
on page 145.

With the Update HP
Tools wizard in HP
Client Manager.

Both of these methods update the tools that are on the Notification Server
computer and then roll out the updates to the client computers.
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About updating HP tools automatically
The HP tools consist of HP Instant Support System Health Scan, HP Instant
Support Diagnostics, and HP System Software Manager (SSM). You need to
download updated versions of these tools from the HP Web site when HP makes
them available.

See “About the HP tools in HP Client Manager” on page 143.

HP Client Manager installs a Windows scheduled task that updates the HP tools
automatically. It first updates the tools that are on the Notification Server
computer and then rolls out the updates to the client computers.

By default, this task is scheduled to run at 2:30 A.M. daily, but you can edit the
task to change the schedule.

The update task is available on the Windows Control Panel, under Scheduled
Tasks > NS.HP Tool Update.

Performing the update daily helps keep the tools current without the need to run
the Update HP Tools wizard manually. You can still run the wizard manually
when it is necessary.

See “Updating HP tools with the Update HP Tools wizard” on page 145.

Updating HP tools with the Update HP Tools wizard
The HP tools consist of HP Instant Support System Health Scan, HP Instant
Support Diagnostics, and HP System Software Manager (SSM). You need to
download updated versions of these tools from the HP Web site when HP makes
them available.

See “About the HP tools in HP Client Manager” on page 143.

Typically, these tools are updated daily by a Windows scheduled task.

See “About updating HP tools automatically” on page 145.

You can run the UpdateHPTools wizard to perform an update between the times
when the scheduled task runs. It first updates the tools that are on the Notification
Server computer and then rolls out the updates to the client computers.

The UpdateHPTools page of the wizard displays the latest version and download
date for each tool. This information includes the downloads that are performed
automatically with the Windows scheduled task.
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To update HP tools with the Update HP Tools Wizard

1 On the HP Client Manager Home page, under Administrative Tasks, click
Update HP Tools.

2 On the Update HP Tools page, select the tools to update.

The HPInstantSupportSystemHealthScan check box updates both the HP
Instant Support System Health Scan tool and the HP Instant Support
Diagnostics tool.

3 Click Update.

4 When the download is complete, you can close the window.

About HP backup and recovery
You can perform automatic, remote backups of your managed HP computers. HP
Client Manager uses the HP Backup and Recovery Manager tool to run and report
the backups. HP includes this tool on certain of its business desktop and notebook
computers.

The HP Backup task performs a one-time backup of the primary drive on each HP
client computer. The backup data is stored in a protected area on the primary
hard drive.

See “Performing an HP backup” on page 147.

If an HP client computer suffers a data loss, you can restore its data from the
backup. You perform the data restoration on the client computer, using the HP
Backup and Recovery Manager tool. The data restoration cannot be performed
remotely.

See “Performing a disaster recovery” on page 148.

Warning: This backup process is intended for disaster recovery only. You cannot
recover the backed-up folders or files individually.

Requirements for HP backup and recovery
HP Client Manager lets you perform automatic, remote backups of your managed
HP computers for disaster recovery purposes. If an HP client computer suffers a
data loss, you can restore its data from the backup. For the backup and recovery
to work, your system must meet certain requirements.

The HP backup has the following requirements:
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■ The client computers to be backed up must have HP Backup and Recovery
Manager installed.
These computers are identified during the HP Client Inventory and are added
to the following filter: Computers with HP Backup and Recovery Manager
installed.

■ The scheduler.exe that is supplied with HP Backup and Recovery Manager
must be version 1.0.4.0 or later.

■ Software Management Solution 7.x must be installed on the Symantec
Management Platform.
If this solution is not installed, the HP Backup task is not available.

See “Performing an HP backup” on page 147.

The disaster recovery process has the following requirements:

■ The client computer to be restored must have HP Backup and Recovery Manager
installed.

■ The client computer must have been backed up.

■ The disaster recovery must be performed on the client computer with the HP
Backup and Recovery Manager tool.
HP Client Manager cannot restore the backup remotely.

See “Performing a disaster recovery” on page 148.

See “About HP backup and recovery” on page 146.

Performing an HP backup
The HP Backup task lets you perform automatic, remote backups of your managed
HP computers.

By default, this task runs at 2:00 A.M. daily. It runs automatically on the computers
that belong to the following filter: Computers where HP Backup Task has not run.
After the task runs on a particular computer, that computer is no longer a member
of the filter and is not backed up again. If you need to back up that computer again,
run the task specifically for that computer or for another filter that the computer
belongs to.

You do not need to take action on this task except to run it on a different schedule
or on a different group of computers.

The Packagesettings section of this task is read only because changing the settings
incorrectly can cause the backup to fail.
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For the HP backup to work, your system must meet certain requirements. For
example, the HP Backup task is available only if Software Management Solution
7.x is installed on the Symantec Management Platform.

See “Requirements for HP backup and recovery” on page 146.

Warning: This backup process is intended for disaster recovery only. You cannot
recover the backed-up folders or files individually.

See “About HP backup and recovery” on page 146.

To view or schedule the HP Backup task

1 On the HP Client Manager Home page, under Management Tasks, click
Backup > HP Backup and Recovery.

See “Accessing the HP Client Manager Home page” on page 62.

2 On the HPBackupTask page, under TaskStatus, you can view the details of
the task, run the task, or create a new schedule.

See “Scheduling and selecting target computers in an HP Client Manager
task” on page 65.

3 When you finish viewing or scheduling the task, you can close the task page.

Performing a disaster recovery
HP Client Manager uses the HP Backup and Recovery Manager tool to perform
automatic, remote backups of your managed HP computers. If an HP client
computer suffers a data loss, you can restore its data from the backup.

See “About HP backup and recovery” on page 146.

Warning: This restoration process is intended for disaster recovery only. You
cannot recover the backed-up folders or files individually.

For more information about using HP Backup and Recovery Manager, see the
documentation or help that is provided with that product.

To perform a disaster recovery

1 On the HP client computer that requires the recovery, restart the computer.

2 When the Press F11 for emergency recovery prompt appears, press F11.

3 In the WelcometoPCRecovery window, click RecoverPCtoaspecificpoint
in time, and then click Next.
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4 In the list of recovery points that appears, select the appropriate recovery
point, and then click Next.

The backups that HP Client Manager creates are stored in a protected area
on the primary hard drive.

5 To begin the recovery process, in the SmartPCRecovery window, select one
of the following options:

Lets you preserve any existing files that were updated or
created since this recovery point or backup were created.

Browse new and
updated files to
preserve

Performs the recovery without preserving any changes to the
operating system configuration or applications that were
made after this recovery point or backup were created.

Recover PC without
preserving new and
updated files

6 Follow any screen prompts to perform and finish the disaster recovery process.

Purging HP data
The data that is collected from managed HP computers is stored in the CMDB
(Configuration Management Database). To manage the size of the CMDB, you can
specify how long certain types of data are stored. You can configure the purge
settings based on the age of the data or on the number of rows in the database.

Your options for purging HP Client Manager data are as follows:

If you plan to use the default global settings, no further action
is required.

The default global settings specify a retention date of six months
and a maximum of 1000000 table rows.

Warning: These settings control the purging of all the data in
the CMDB. Change them only if you intend to affect all the data.

Use the global settings.

You can override the global settings for the HP Client Manager
data class.

Customize the settings
for HP Client Manager.

For more information about purging the Configuration Management Database,
see the Symantec Management Platform Help.
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To configure purging settings for HP data

1 In the Symantec Management Console, on the Settings menu, click
Notification Server > Purging Maintenance.

2 In the left pane, click Purging Maintenance > Purging Maintenance.

3 In the right pane, on the Purging Maintenance page, click the Resource
Event Data Purge Settings tab.

4 Ensure that the Configured option is selected.

5 Click Select DataClasses.

6 In the Items Selector dialog box, click HP Client Manager or expand the
folder and select specific data classes, and then click Save Changes.

7 On the Resource Event Data Purge Settings tab, specify the purge settings
for the data classes that you selected.

8 On the Purging Maintenance page, click Save changes, and then close the
page.

Uninstalling the HP Client Manager Agent
You can uninstall the HP Client Manager Agent from managed HP computers.

The HP Client Manager Uninstall policy performs the agent uninstall. By default,
this policy is turned off. You must schedule and turn on (enable) the policy to
uninstall the agent.

To uninstall the HP Client Manager Agent

1 In the Symantec Management Console, on the Settings menu, click All
Settings.

2 In the left pane, click Agent/Plug-ins>HPClientManagerAgent>HPClient
Manager Agent Uninstall.

3 On the plug-in installation page, under Applied To, select the target
computers.

Warning: The default filter is All HP Computers with HP Client Manager
Installed. If you use the default filter, the agent is uninstalled from all
computers. In most cases, you should select the computers individually.

For more information, see the topics about specifying the targets of a policy
in the Symantec Management Platform Help.
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4 Under Schedule, click Addschedule to schedule the policy to run at a specific
date and time or during a span of time.

You can specify as many schedules as you need.

For more information, see the topics about specifying a policy schedule in
the Symantec Management Platform Help.

5 Turn on the policy.

At the upper right of the page, click the colored circle, and then click On.

6 Click Save changes.
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